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Preface

TIBCO BusinessConnect™ EDI Protocol powered by Instream® is the TIBCO 
business-to-business (B2B) solution for transferring EDI documents between trading 
partners. This manual describes how to use the X12 protocol.

Topics

• Related Documentation, page xii

• Typographical Conventions, page xiv

• TIBCO Product Documentation and Support Services, page xvi
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Related Documentation

This section lists documentation resources you may find useful.

TIBCO BusinessConnect EDI Protocol powered by Instream Documentation

The following documents form the TIBCO BusinessConnect EDI Protocol powered by 
Instream documentation set:

• TIBCO BusinessConnect EDI Protocol powered by Instream Installation Read this 
manual to learn about installing and deploying TIBCO BusinessConnect EDI Protocol 
powered by Instream. 

• TIBCO BusinessConnect EDI Protocol powered by Instream User’s Guide Read this 
manual for instructions on using the product to configure all the EDI protocols.

• TIBCO BusinessConnect EDI Protocol powered by Instream EDIFACT 
Configuration Read this manual for instructions on configuring the EDIFACT 
protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream Gateway 
Configuration Read this manual for instructions on configuring the Gateway 
protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream Service 
Configuration Read this manual for instructions on configuring the Service protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream TEXT 
Configuration Read this manual for instructions on configuring the TEXT protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream TRADACOMS 
Configuration Read this manual for instructions on configuring the TRADACOMS 
protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration Read 
this manual for instructions on configuring the X12 protocol.

• TIBCO BusinessConnect EDI Protocol powered by Instream Release Notes Read the 
release notes for a list of new and changed features. This document also contains lists 
of known issues and closed issues for this release.
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Other TIBCO Product Documentation

You may find it useful to read the documentation for the following TIBCO products:

• TIBCO ActiveMatrix BusinessWorks™

• TIBCO ActiveMatrix BusinessWorks™ Plug-in for BusinessConnect™

• TIBCO Administrator™

• TIBCO BusinessConnect™

• TIBCO BusinessConnect™ Palette

• TIBCO Business Studio™

• TIBCO Designer™
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Typographical Conventions

The following typographical conventions are used in this manual.

Table 1   General Typographical Conventions

Convention Use

ENV_HOME

TIBCO_HOME

TIBEDI_HOME

TIBCO products are installed into an installation environment. A product installed into 
an installation environment does not access components in other installation 
environments. Incompatible products and multiple instances of the same product must be 
installed into different installation environments.

An installation environment consists of the following properties:

• Name Identifies the installation environment. This name is referenced in 
documentation as ENV_NAME. On Microsoft Windows, the name is appended to the 
name of Windows services created by the installer and is a component of the path to 
the product shortcut in the Windows Start > All Programs menu. 

• Path The folder into which the product is installed. This folder is referenced in 
documentation as TIBCO_HOME. 

TIBCO BusinessConnect EDI Protocol powered by Instream installs into a directory 
within a TIBCO_HOME. This directory is referenced in documentation as 
TIBEDI_HOME. The default value of TIBEDI_HOME depends on the operating system. 
For example, on Windows systems, the default value is C:\tibco\bc\version\protocols\tibedi.

code font Code font identifies commands, code examples, filenames, pathnames, and output 
displayed in a command window. For example:

Use MyCommand to start the foo process.

bold code font Bold code font is used in the following ways:

• In procedures, to indicate what a user types. For example: Type admin. 

• In large code samples, to indicate the parts of the sample that are of particular 
interest.

• In command syntax, to indicate the default parameter for a command. For example, 
if no parameter is specified, MyCommand is enabled: 
MyCommand [enable | disable]
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italic font Italic font is used in the following ways: 

• To indicate a document title. For example: See TIBCO BusinessConnect EDI 
Protocol powered by Instream Installation.

• To introduce new terms. For example: A portal page may contain several portlets. 
Portlets are mini-applications that run in a portal.

• To indicate a variable in a command or code syntax that you must replace. For 
example: MyCommand PathName.

Key 
combinations

Key names separated by a plus sign indicate keys pressed simultaneously. For example: 
Ctrl+C.

Key names separated by a comma and space indicate keys pressed one after the other. 
For example: Esc, Ctrl+Q.

The note icon indicates information that is of special interest or importance, for example, 
an additional action required only in certain circumstances.

The tip icon indicates an idea that could be useful, for example, a way to apply the 
information provided in the current section to achieve a specific result.

The warning icon indicates the potential for a damaging situation, for example, data loss 
or corruption if certain steps are taken or not taken.

Table 1   General Typographical Conventions (Cont’d)

Convention Use
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration
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TIBCO Product Documentation and Support Services

For information about this product, you can read the documentation, contact TIBCO 
Support, or join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation 
website mainly in the HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current 
than any other documentation included with the product. To access the latest 
documentation, visit https://docs.tibco.com. 

Documentation for TIBCO BusinessConnect EDI Protocol powered by Instream is 
available on the 
https://docs.tibco.com/products/tibco-businessconnect-edi-protocol-powered-by-instream
Product Documentation page.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

• For an overview of TIBCO Support, and information about getting started with 
TIBCO Support, visit http://www.tibco.com/services/support

• For accessing the Support Knowledge Base and getting personalized content about 
products you are interested in, visit the TIBCO Support portal at 
https://support.tibco.com.

• For creating a Support case, you must have a valid maintenance or support contract 
with TIBCO. You also need a user name and password to log in to 
https://support.tibco.com. If you do not have a user name, you can request one by 
clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee 
subject matter experts to share and access their collective experience. TIBCO Community 
offers access to Q&A forums, product wikis, and best practices. It also offers access to 
extensions, adapters, solution accelerators, and tools that extend and enable customers to 
gain full value from TIBCO products. In addition, users can submit and vote on feature 
requests from within the TIBCO Ideas Portal. For a free registration, go to 
https://community.tibco.com.
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Chapter 1 X12 Overview

This chapter briefly describes the X12 standard and its use for Electronic Data Interchange 
(EDI). For a more complete description of the X12 standard, see the standard itself, which 
can be found at the Data Interchange Standards Association (DISA) website: 

http://www.disa.org

Topics

• Product Overview, page 2

• Document Structure, page 3

• Delimiters, page 6

• Acknowledgments, page 7

• Support for File Conversion, page 9

• HIPAA Acknowledgment Properties, page 10
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration
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Product Overview

EDI is the exchange of information between trading partners, which the information is 
formatted in according to a set of common data format standards developed in the U.S. 
and Western Europe during the late 1970s. EDI standards define the vocabulary, syntax 
rules, and structure of electronic documents. 

X12 is an EDI standard from the American National Standards Institute (ANSI). The 
Accredited Standards Committee (ASC) X12 develops and maintains the X12 standards. 
In the X12 standard, a transaction set contains the data for a well-defined business 
function, for example, a purchase order. Today, more than three hundred X12 transaction 
sets are used by more than thirty thousand organizations for nearly every facet of 
business-to-business (B2B) operations.
TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration
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Document Structure

An X12 document is a file containing EDI data to be exchanged between trading partners. 

An X12 document includes the following basic structures: 

• Interchange, page 3

• Functional Group, page 4

• Transaction Set, page 4

The following sections provide a basic description of each of these structures. For more 
detailed information on each of these structures, please see the X12 standard.

Interchange

The interchange is the basic unit of electronic data transfer. Several interchanges can be 
bundled into a single file for data transfer. 

An interchange starts with an interchange header (ISA segment), and ends with an 
interchange trailer (IEA segment). 

Figure 1   Structure of X12 Interchange

In X12, the interchange header (ISA) performs the following functions:

• Defines the delimiters used in the interchange.

• Identifies the sender and receiver.

• Provides control information for the interchange.

• Allows for authorization and security information.

The following example of an X12 interchange contains an 850 (purchase order) 
transaction set:
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ISA~00~Authorizat~00~Security I~01~123456789      ~01~987654321      
~040418~1338~U~00403~000000001~0~I~+^
GS~PO~Application Sen~Application Rec~20040418~1338~1~X~004030^
ST~850~0001^
BEG~00~CO~PO#39281~Release Number~20040418^
REF~……….
N1~…………
PO1~……….
PO1~……….
. . .
CTT~……….
SE~70~0001^
GE~1~1^
IEA~1~000000001^

Functional Group

A functional group is a group of similar transaction sets, for example, three purchase 
orders.

It is a group of one or more related transaction sets sharing the same functional group ID. 
Functional groups start with the segment GS Functional Group Header, and end with the 
segment GE Functional Group Trailer. 

The details in the Functional Group GS/GE envelope are often used to route the group 
transaction sets to the appropriate department or business application within a company.

Transaction Set

A transaction set contains the data for a well-defined business function. For example, X12 
transaction sets can be used for purchase orders, invoices, and financial statements. 

A business transaction is defined by a transaction set composed of a number of segments 
of variable lengths. Each segment is in turn composed of a number of data elements of 
variable lengths. A transaction set is analogous to a business document, such as a purchase 
order. A segment is analogous to a line of information in that purchase order. A data 
element is analogous to a unit of information in the item line. For example, in the purchase 
order for a book, the number of copies requested or the unit price is represented by data 
elements. 

Normally, all of the data in an X12 interchange is on one line. The example here has the 
data split across several lines in order to fit on the page. However, it is not unusual for X12 
data to be split on segment boundaries or even blocked at a particular number of 
characters. 
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Transaction Set Header and Transaction Set Trailer

Each transaction set starts with a transaction set header (ST), followed by a beginning 
segment that uniquely identifies the type of transaction set. The transaction set header 
contains the transaction set identification and transaction set control number. The 
beginning segment is followed by other segments, which might also be found in other 
transaction sets, and is concluded by a transaction set trailer. 

The transaction set trailer (SE) is the last element in the transaction set. It defines the end 
of the transaction set, and contains the number of segments included and the transaction 
set control number. 
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Delimiters

Delimiters separate various syntax structures of an X12 document. 

Delimiters consist of three separators and a terminator. Each interchange in an X12 
document specifies the set of delimiters to use for that interchange. 

The delimiters to be used in the interchange are defined in the interchange header segment 
(ISA). The delimiters contain the following items:

• Data element separator

• Component element separator

• Replacement character

• Segment terminator

The delimiter characters defined in the ISA segment must not be used in a data element 
value elsewhere in the interchange. However, defined delimiter characters can appear 
within a binary data element.

Only one character per delimiter can be used for the X12 Protocol.
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Acknowledgments

Acknowledgments for X12 documents fall into three categories.

• Delivery Acknowledgments, page 7

• Syntactic Response Acknowledgments, page 7

• Business Application Acknowledgments, page 7

You must have an agreement with your trading partner to use acknowledgments. 

Delivery Acknowledgments

Two interchange delivery acknowledgments exist for X12 documents.

• Interchange acknowledgment segment (TA1)

An interchange acknowledge segment (TA1) reports the receipt of the contents of one 
interchange control header and trailer envelope, in which the envelope surrounds one 
or more functional groups. The TA1 reports the results of the syntactical analysis of 
the interchange control header and trailer. Each interchange exchanged between 
trading partners might contain interchange-level control segments (TA1s) related to 
prior interchanges.

• Interchange delivery notice segment (TA3)

An interchange delivery notice (TA3) reports the delivery status of a document, when 
an intermediary is used to transfer documents between an interchange sender and 
interchange receiver.

Syntactic Response Acknowledgments

Two syntactic response acknowledgments exist for X12 documents.

• Functional acknowledgment (997)

The functional acknowledgment (997) describes the syntax-level acknowledgment of 
the receipt of an X12 functional group.

• Implementation acknowledgment (999)

The implementation acknowledgment (999) is first available in the X12 004061 
subrelease. It is used for reporting the status of implementation guide syntax edits.

Business Application Acknowledgments

Business application acknowledgments includes two different types.
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• Application advice (824)

The application advice (824) reports the results of an application system's data content 
edits on a transaction set. The results of editing transaction sets can be reported at the 
functional group and transaction set level, in either coded or free-form format. 

The 824 is designed to report the following information for a transaction set:

— Acceptance

— Rejection

— Acceptance with change

• Specific response transaction (Example: 271 response to a 270)

The status of a transaction set can also be reported by using a specific response 
transaction set as a response to the original transaction set. 

The following information are examples of transaction set pairs where the status of the 
original transaction set is indicated in the response transaction set:

— 271 response to a 270

— 855 response to an 850

— 870 response to an 869
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Support for File Conversion 

The X12 protocol supports different types of file conversions.

• Validation of X12 documents and their conversion to TEXT files, either delimited or 
positional, based on the TEXT guidelines developed in TIBCO Foresight® EDISIM® 
and mapped by using the Translator tool. 

• Conversion of the TEXT files to EDI for the Notify operation where TEXT files are 
converted to X12 protocol. To perform this conversion, the trading partner must 
enable both the TEXT and X12 protocol.

• Conversion of TEXT data to X12 by using the synchronous request response 
transactions.

For more details about TEXT to EDI conversion, see TIBCO BusinessConnect EDI 
Protocol powered by Instream User’s Guide, "TEXT to EDI Conversion."
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration
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HIPAA Acknowledgment Properties

Business Application Acknowledgments

The following information is a list of the versions of business application 
acknowledgments that TIBCO BusinessConnect EDI Protocol powered by Instream 
supports:

• 00405/004050X166/824 - generated for 4010 HIPAA transactions

• 00501/005010X186A1/824 - generated for 5010 HIPAA transactions

• 00307/003070X070A1/277 - generated for 4010 HIPAA transactions

• 00404/004040X167/277 - generated for 4010 HIPAA transactions

• 00501/005010X214/277 - generated for 5010 HIPAA transactions

TIBCO BusinessConnect EDI Protocol powered by Instream can automatically generate 
the following business application acknowledgments:

• Application advice (824)

• Unsolicited Health Care Claim Status Notification (277U)

• Health Care Claim Acknowledgment (277CA)

The 824 application advice reports the results of an application system's data content edits 
on a transaction set. The results of editing transaction sets can be reported at the functional 
group and transaction set level, in either coded or free-form format. 

The 824 is designed to report the following information for a transaction set:

• Acceptance

• Rejection

• Acceptance with change

The unsolicited health care claim status notification (277U) reports the results of an 
application system's data content edits on the claims in a transaction set. 

The 277 Claim Acknowledgment (277CA) has replaced the usage of the 277U Unsolicited 
Health Care Claim Status Notification. The 277 Claim Acknowledgment reports the 
results of an application system data content edits on the claims in a HIPAA 837 
transaction.

You can use the HIPAA Acknowledgement tab to specify settings to be used in 
composing these business application acknowledgments for documents sent by this 
trading partner. These settings only take effect if you have enabled transaction level 
acknowledgments in the Acknowledgement tab. 
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The 997 or 999 acknowledgment that is generated when 824 application advice 
acknowledgments are also generated, only contains the results of the X12 and HIPAA 
syntax validation edits for the transaction.

999 Acknowledgments

In accordance with the 5010 transaction TR3s, TIBCO BusinessConnect EDI Protocol 
HIPAA Edition powered by Instream can be configured to generate version 
005010X231A1 999s for all HIPAA 5010 transactions.

You can use the HIPAA Acknowledgement tab to enable the option for generating 
version 005010X231A1 999s. This setting overrides any other 997 or 999 
acknowledgment generation settings for 00501 interchanges, which contain HIPAA 5010 
transactions.

See Table 2 for details.

Table 2   HIPAA Acknowledgment Fields

Field Description

824 
Application 
Advice 
Creation

Select one option to define when 824 acknowledgments are created for this partner by the 
host. 

The possible acknowledgment creation options are:

• None No acknowledgment is created. By default, None is selected.

• Always The acknowledgment is created whether there are validation errors to be 
reported or not. The acknowledgment contains all validation edit information other 
than that which is related to syntax checking for X12 and HIPAA. 

• Only on Errors The acknowledgment is only created if errors that are not related to 
X12 syntax or HIPAA syntax occur in validation.

824 
Application 
Advice Version

Select the version of the 824 Application Advice that is generated:

• 004050X166 This version of 824 application advice is only generated for version 
4010 HIPAA transactions. By default, 004050X166 is selected.

• 005010X186 This version of 824 application advice is only generated for version 
5010 HIPAA transactions.

• 004050X166 & 005010X186  These versions of 824 application advice are generated 
for both version 4010 and 5010 HIPAA transactions.
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277 Health 
Care 
Notification 
Creation

Select one option to define when a 277U or 277CA acknowledgment is created for this 
partner by the host. 

277U or 277CA acknowledgments are only created for 837 transactions.

The possible acknowledgment creation options are:

• None No acknowledgment is created (default).

• Always The acknowledgment is created whether validation errors are reported or 
not. The acknowledgment contains all validation edit info including that which is 
related to syntax checking for X12 and HIPAA.

277 Health 
Care 
Notification 
Version

Select the version of the 277U or 277CA that is generated:

• 003070X070A1 - Unsolicited Claim Status A 277U is only generated for version 
4010 HIPAA transactions. (default)

• 004040X167 - Claim Acknowledgement A 277CA is only generated for version 
4010 HIPAA transactions.

• 005010X214 - Claim Acknowledgement A 277CA is only generated for version 
5010 HIPAA transactions.

• 004040X167 & 005010X214 - Claim Acknowledgement A 277C is generated for 
both version 4010 and 5010 HIPAA transactions.

• 003070X070A1 & 005010X214 - Claim Acknowledgement A 277U is generated for 
4010 HIPAA transactions, and a 277CA is generated for 5010 HIPAA transactions.

005010X231A1 
999 Ack 
Creation

Select one option to enable generation of version 005010X231A1 999 acknowledgments 
for HIPAA 5010 transactions.

• Off 997 and 999 acknowledgment settings from the Acknowledgement tab apply to 
all transactions.

• 5010 HIPAA Transactions Version 005010X231A1 999s are generated for 00501 
interchanges, which contain HIPAA 5010 transactions. The Inbound Ack Creation 
Option setting from the Acknowledgement tab is still applied, for example, 
Interchange, Group, and Txn.

Table 2   HIPAA Acknowledgment Fields (Cont’d)

Field Description
TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration
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Chapter 2 Tutorials — Getting Started

This chapter describes how to use TIBCO ActiveMatrix BusinessWorks with TIBCO 
BusinessConnect EDI Protocol powered by Instream.

You have to configure trading partner information, configure a private process to 
communicate with TIBCO BusinessConnect EDI Protocol powered by Instream, and run 
the tutorials.

Topics

• Prerequisites, page 14

• Using EDI Guidelines, page 15

• Configuring the Initiator, page 19

• Configuring Private Processes, page 25

• Send 850 Txn To BC, page 30

• Receive 850 TEXT Process, page 38

• CAQH Sample, page 42
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Prerequisites

Before starting the tutorial, you must complete the corresponding tasks.

1. Install the following software packages:

a. TIBCO BusinessConnect (Server)

b. TIBCO BusinessConnect Palette or TIBCO ActiveMatrix BusinessWorks Plug-in 
for BusinessConnect

c. TIBCO Foresight® Instream® Standard Edition

d. TIBCO Foresight® Translator Standard Edition

e. TIBCO BusinessConnect EDI Protocol powered by Instream

2. If you are unfamiliar with the X12 standard, read Chapter 1, X12 Overview, on 
page 1.

3. For complete information on setting up and running TIBCO BusinessConnect, see 
TIBCO BusinessConnect Interior Server Administration and TIBCO BusinessConnect 
Trading Partner Administration.

4. Review "Setting Up Trading Partners" in TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide.

5. Activate TIBCO BusinessConnect EDI Protocol powered by Instream.
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Using EDI Guidelines

You can find the guidelines that are used for this tutorial in the 
BC_HOME\protocols\tibedi\samples\sampleDocs\guidelines directory.

The guideline file names are:

• X12_4030_850.std

• X12_5010_850.sef

• X12_5010_997.sef

• X12_5010_999.sef

• X12_TA1.sef

Viewing a Guideline

This procedure explains how to view the guideline used in the tutorial.

To import a guideline:

1. Start TIBCO Foresight EDISIM.

2. Click Standards Editor.

The Empty Guideline - Edisim dialog is displayed.

3. From the menu, click File > Import > Import Single .SEF and Open.

4. Navigate to the BC_HOME\protocols\tibedi\samples\sampleDocs\guidelines directory. 

5. Select the X12_5010_850.sef file, and then click Open.

6. If the SEF Import Correction dialog is displayed, click Skip Correction.

7. In the Import Standard dialog, keep or change the standard name, which you want to 
import this guideline into, and click OK.

Figure 2   Import Standard

For this tutorial, keep the standard name as 5010_850 and click OK.
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The imported standard 5010_850 is now displayed.

8. Click  on the left to display the purchase order guideline.

Figure 3   Elements of the Purchase Order

When you expand and highlight elements in the Guideline panel, the properties of 
each element are displayed in the Details View panel.
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Figure 4   Details View Panel

Loading Guidelines to the X12 Protocol

This section describes how to load the guidelines and XSDs for the X12 messages. TIBCO 
BusinessConnect EDI Protocol powered by Instream contains a sample configuration file 
for this tutorial. You can load guidelines to the X12 protocol by importing the 
configuration file into the Operations Editor.

To import the configuration file into the Operations Editor: 

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Operations Editor.

3. In the right panel, click Import.

4. In the Import Operations panel, click change next to the Upload Configuration Data 
File field.

5. In the Change File panel, click Browse next to the Upload file field to navigate to the 
configuration file directory.

6. Select the corresponding configuration file, and then click Open.

— For the first tutorial: BC_HOME\protocols\tibedi\samples\interfaces\X12-00403.csx

— For the second tutorial: BC_HOME\protocols\tibedi\samples\interfaces\ 

X12-850_PO_Positional.csx 

7. In the Change File panel, click OK.

8. In the Import Operations panel, set a password (optional) and click Import.
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



18 | Chapter 2  Tutorials — Getting Started
Reviewing the Guidelines

This procedure describes how to review the guideline loaded for the purchase order 
transaction.

1. Click the X12 link.

2. In the Edit Operations: X12 dialog, click the topmost expand all  to display all 
X12 operations.

Figure 5   X12 Operations

3. Click the 00403 > 005010 > 850 transaction link.

4. Click the Guideline tab.

Note that X12_5010_850.sef is displayed in the Guideline File for validating X12 
Partner data (.sef or .std) field. 

5. Click Save to save the configurations.

6. In the Edit Operations: X12 dialog, click Done.
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Configuring the Initiator 

This section steps you through the activities you need to perform to configure a host and a 
trading partner on an Initiator machine that runs on the Windows platform.

As explained before, this tutorial is run on a single machine (Initiator) and when the 850 
transaction is sent to the trading partner, the transport properties are defined to store the 
request in a directory on the local file system.

To proceed with the tutorial, perform the following tasks:

• Ensure that you have uploaded guidelines for this tutorial as described in Loading 
Guidelines to the X12 Protocol, page 17

• Setting Up a Host, page 19

• Setting Up a Partner, page 21

• Configuring the Business Agreement, page 23

• Deploying the Initiator Server, page 23

Setting Up a Host

To set up a trading host on the Initiator machine, you have to complete the following tasks: 

1. Creating a Host, page 19

2. Setting the Interchange Qualifier and ID for the Host, page 20

3. Activating the Host

Creating a Host

To create and set up the default host:

1. Log on to TIBCO Administrator. 

2. In the left panel, expand BusinessConnect > Participants. 

3. In the right panel, click New.

4. In the Name field, type Company1.

5. From the Type list, select Host.

6. Click OK to create a host. 

7. Click Save to save the configurations.
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Enabling the X12 Protocol for the New Host

All EDI protocols are enabled by default after installation. To configure and activate any 
of the protocols, you must disable all other unconfigured protocols. Once the protocols are 
configured, you can enable or disable them at any time: this procedure is needed only 
when configuring protocols for the first time.

1. In the right panel, click the Company1 link. 

2. Click the Protocols tab.

3. In the Protocols tab, perform the following configurations:

a. Select the check boxes next to EDI protocols other than X12. 

b. Click Disable.

If protocols have not been enabled:

a. Click Enable.

b. Select the check box next to X12, and then click OK.

Setting the Interchange Qualifier and ID for the Host

To set the Interchange Qualifier and ID for the host:

1. Click the X12 link.

2. Click the Add New link next to the Default Interchange Qualifier ID field.

3. Click the Add New button.

4. From the Interchange Qualifier list, select a qualifier such as 01.

In the ID field, type a name such as 987654321.

5. Click Save and OK.

6. From the Default Interchange Qualifier ID list, select 01-987654321.

7. Click Save twice. 

Activating the Host

1. In the left panel, expand BusinessConnect > Participants again.

Verify that the host, Company 1, has the Domain Identity you have defined in Setting 
the Interchange Qualifier and ID for the Host: (01)987654321.

2. Click the Company1 link.

3. In the General tab of the Edit Host Participant: Company1 dialog, select the Active 
check box.
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4. Click Save to save the configurations.

5. In the left panel, expand BusinessConnect > System Settings. 

6. In the right panel, click General, and verify that Company1 is selected from the 
Default Host field as the default host. 

Setting Up a Partner

The trading partner setup consists of these steps:

• Creating a Partner, page 21

• Enabling the X12 Protocol for the Partner, page 21

• Setting the Interchange Qualifier and ID for the Partner, page 22

• Enabling Outbound EDI Validation, page 22

• Setting the Transport, page 22

Creating a Partner 

To set up a partner, you must first create one partner.

To create a trading partner:

1. In the left panel, expand BusinessConnect > Participants. 

2. In the right panel, click New to create a participant.

3. In the Name field, type Company2.

4. From the Type list, select Partner.

5. Click OK to create a partner.

6. In the General tab, elect the Active check box.

7. Click Save to save the configurations.

The new partner Company2 is displayed in the Participants list, with no identity 
defined. 

Enabling the X12 Protocol for the Partner

After creating a partner, you must enable the X12 protocol for the partner.

1. In the right panel, click the Company2 link.

Saving of the trading host succeeds only if the protocol is properly configured: the 
protocol is enabled and a qualifier/ID is provided.
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2. Click the Protocols tab.

3. In the Protocols tab, click Enable.

4. Select the X12 check box.

5. Click OK to enable the X12 protocol.

Setting the Interchange Qualifier and ID for the Partner

This procedure describes how to set the interchange qualifier and ID for the partner.

1. Click the X12 link.

2. Click the Add New link next to the Default Interchange Qualifier ID field.

3. Click the Add New button.

4. From the Interchange Qualifier list, select 01.

5. In the ID field, type 123456789.

6. Click Save. 

7. Click OK.

8. From the Default Interchange Qualifier ID list, select 01-123456789.

9. Click Save to save the configurations.

Enabling Outbound EDI Validation

This procedure describes how to enable outbound EDI validation.

1. Click the X12 link.

2. In the Outbound area of the General tab, select the Enable EDI Validation check 
box.

3. Click Save to save the configurations.

Setting the Transport

This procedure describes how to set the transport.

1. Click the X12 link.

2. Click the Transports tab.

3. Click Add.

4. In the Name field, type FILE.

5. From the Type list, select FILE.
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6. Click OK.

7. In the URL field, type C:/testEDI/out.

8. Click Save three times to save the configurations.

Configuring the Business Agreement

After setting up a partner, you must configure the business agreement.

1. In the left panel, expand BusinessConnect > Business Agreements. 

2. In the right panel, click New.

3. Click Company1 in the Host Party area and Company2 in the Partner Party area.

4. Click OK.

5. In the Protocol Bindings area, click Add Protocol Binding.

6. Select the X12 check box.

7. Click OK.

8. In the Protocol Bindings area, click the X12 link.

9. Click the Transports tab.

10. In the Outbound Transports for Host ‘Company1’ area, ensure that FILE is 
selected from the Primary Transport list.

11. Click Save twice to save the configurations.

The new agreement between Company1 and Company2 with the enabled X12 
protocol is displayed.

Deploying the Initiator Server

You must set up and deploy the Initiator server to communicate with trading partners.

To deploy the Initiator server:

1. Create the deployment configuration. 

See TIBCO BusinessConnect Interior Server Administration for information on 
deployment configurations.

Forward slashes are used in the path as opposed to the Windows backslash. This is 
because the fields of the TIBCO BusinessConnect console are HTML user interface 
text components. As with any HTML user interface text component, the backslash (\) 
is treated as an escape character.
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2. Deploy TIBCO BusinessConnect, and then start the server.
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Configuring Private Processes

TIBCO BusinessConnect EDI Protocol powered by Instream contains a sample TIBCO 
ActiveMatrix BusinessWorks project that sends an X12 850 transaction to TIBCO 
BusinessConnect. 

This section describes how to configure private processes in the following ways: 

• Configuring Private Processes in TIBCO Designer, page 25

• Configuring Private Processes in TIBCO Business Studio, page 28

Configuring Private Processes in TIBCO Designer

To configure private processes in TIBCO Designer, you have to open the sample project, 
and then configure connections to TIBCO BusinessConnect.

1. Opening the TIBCO ActiveMatrix BusinessWorks Project, page 25

2. Configuring Connections to BusinessConnect, page 26 

Opening the TIBCO ActiveMatrix BusinessWorks Project

To configure private processes, you must open the sample TIBCO ActiveMatrix 
BusinessWorks project in TIBCO Designer.

To open the sample project:

1. Start TIBCO Designer and click New empty project.

2. In the Save Project dialog, click Cancel.

3. From the menu, click Project > Import Full Project.

4. Click the ZIP Archive tab. 

5. In the ZIP Archive tab, click  next to the File field to navigate to the 
BC_HOME\protocols\tibedi\samples\bw\X12_850 directory.

6. Select the X12_850.zip file and click Open. 

7. Click OK. 

8. In the Options tab of the Import - Options dialog, click Try rename in case of name 
conflict, and then click Apply.

9. From the menu, click Project > Save As.

10. In the Multi-File Project tab of the Save Project dialog, click  next to the Project 
Directory field to navigate to the BC_HOME\protocols\tibedi\samples\bw\X12_850 directory.
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11. Click OK.

12. In the Save Project dialog, click OK. 

13. When a dialog is displayed asking to use the directory as a project directory, click Yes. 

The .zip archive file is deleted from the BC_HOME\protocols\tibedi\samples\bw\X12_850 
directory. The window shown in Figure 6 is displayed.

Figure 6   TIBCO ActiveMatrix BusinessWorks Project

14. Click the Global Variables tab.

15. In the Global Variables dialog:

a. Set BCHome to your TIBCO BusinessConnect installation directory.

b. Ensure that the TPName variable is defined as Company2.

c. Click OK to save the global variable changes.

16. If you make any changes, save the project but do not exit TIBCO Designer.

Configuring Connections to BusinessConnect

After opening the sample project, you must configure connections to TIBCO 
BusinessConnect so that TIBCO ActiveMatrix BusinessWorks can communicate with 
TIBCO BusinessConnect.
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To configure connections to TIBCO BusinessConnect:

1. Click the Project tab.

2. In the BCServerConnection folder, double-click BCServerConfig.

3. Click the BusinessConnect Server Access tab, and configure the following 
information in the tab:

a. From the JDBC Driver Type list, select the JDBC driver that you want to use to 
communicate with the BusinessConnect configuration store.

b. In the JDBC URL field, type the URL for the configuration store.

c. In the DB User field, type the user name of the configuration store. 

d. In the DB Password field, type the password of the configuration store.

e. Click Apply to save the configurations.

4. Click the Configuration tab.

5. Click Update from Configuration Store. 

If you choose TIBCO Rendezvous as the transport for private communication, the 
software displays a TIBCO Rendezvous tab.

6. From the Protocol Name list, select X12.

7. Click Import Selected Business Protocol. 

TIBCO ActiveMatrix BusinessWorks now retrieves schema information from the 
BusinessConnect configuration store, and saves it in the BCSchemas project folder. 

Figure 7   BCServerConfig: Configuration

8. Click Apply to save the configurations.

9. From the menu, click Project > Save to save the project.
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Configuring Private Processes in TIBCO Business Studio

To configure a private process in TIBCO Business Studio, you have to open the sample 
project, and then configure connections to TIBCO BusinessConnect.

1. Opening the TIBCO ActiveMatrix BusinessWorks Project, page 28

2. Configuring Connections to TIBCO BusinessConnect, page 28

Opening the TIBCO ActiveMatrix BusinessWorks Project

To configure private processes, you must open the sample TIBCO ActiveMatrix 
BusinessWorks project in TIBCO Business Studio.

To open the sample project in TIBCO Business Studio:

1. Start TIBCO Business Studio.

2. From the menu, click File > Import. 

3. On the Import page, expand the General folder and select Existing Studio Projects 
into Workspace. Click Next. 

4. Click Browse next to the Select archive file field to navigate to the 
BC_HOME/protocols/tibedi/samples/bw/X12_850 directory. 

5. Select the X12_850_for_bw6.zip file, and then click Open.

6. Click Finish to import the sample project.

After importing the sample project, you have to perform the following steps:

1. In the Project Explorer view, expand X12_850 > Module Descriptors.

2. Double-click Module Properties.

3. Change the default values of the BCHome and TPName properties according to your 
environment.

Configuring Connections to TIBCO BusinessConnect

After opening the sample project, you must configure connections to TIBCO 
BusinessConnect so that TIBCO ActiveMatrix BusinessWorks can communicate with 
TIBCO BusinessConnect.

To configure connections to TIBCO BusinessConnect:

1. In the Project Explorer view, expand Resources and double-click 
BCConnection.bcResource.

2. Click the Server Access tab.

3. Enter information as explained in step 3.
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4. Click the Configuration tab, and click Update from Configuration Store.

5. Select X12 from the Protocol Name list.

If you select the Select Operations check box, you can select any of the 
configured/imported operations. For this tutorial, select all operations and click OK.

6. Click Import Selected Business Protocol. 

When you import the protocol, TIBCO ActiveMatrix BusinessWorks retrieves 
information from the TIBCO BusinessConnect configuration store, and saves them in 
the project folder.

7. Click Save.
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Send 850 Txn To BC 

In this tutorial, you can use TIBCO ActiveMatrix BusinessWorks and TIBCO 
BusinessConnect EDI Protocol powered by Instream running on one machine to send an 
X12 850 purchase order transaction to a trading partner. 

Normally the trading partner is represented by another B2B engine running on another 
machine. However, this tutorial is run on a single machine. When the 850 transaction is 
sent to the trading partner, the transport properties are defined to store the request in a 
directory on the local file system.

The transaction set identifier information is as follows:

• Transaction set - 850

• Group version - 005010

• Interchange version - 00403

When you run the tutorial, the following operations occur:

1. TIBCO Designer/TIBCO Business Studio reads an XML file, which contains the data 
for an 850 transaction.

TIBCO Designer/TIBCO Business Studio parses the XML data, and sends the XML 
data to TIBCO BusinessConnect EDI Protocol powered by Instream.

TIBCO BusinessConnect EDI Protocol powered by Instream converts the XML data 
to X12 data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against an 850 guideline. 

3. The validated X12 data is bundled into an interchange for sending to the trading 
partner.

4. FILE transport is used to simulate sending the interchange to the trading partner. By 
using FILE transport, the X12 interchange is written to a file on the local file system 
when it is sent to the trading partner.

The following sections describe how to set up and run the tutorial:

• EDI Guideline Authoring

• Trading Partner Setup

• TIBCO ActiveMatrix BusinessWorks Process Assembly
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Processes Overview

Process names are slightly different in TIBCO Designer and TIBCO Business Studio. For 
example, the Send 850 Txn to BC process in TIBCO Designer equals the Send_850_Txn_to_BC 
process in TIBCO Business Studio. The following description takes processes in TIBCO 
Designer as an example.

The X12_850 project contains several processes in two folders: X12 Message Processes and 
Error Advisory Processes.

The X12 Message Processes folder contains the following processes:

• Send 850 Txn to BC

This process reads a file containing the XML equivalent of an 850 transaction, and 
sends the XML data to TIBCO BusinessConnect.

• Receive 997 Acknowledgement

If you are actually communicating with a trading partner in this tutorial, when the 
trading partner receives your interchange containing the 850 transaction, it returns a 
997 acknowledgment. 

• Receive TA1 Acknowledgment

If you are actually communicating with a trading partner in this tutorial, when the 
trading partner received your interchange containing the 850 transaction, it returns a 
TA1 to acknowledge receipt of the interchange.

• Receive Txn Ack Advisory

If you are actually communicating with a trading partner in this tutorial, when the 
Initiator receives the TA1 and 997 without any errors, it sends an acknowledgment to 
the private process to indicate the successful completion of the transaction.

The Error Advisory Processes folder contains processes, which are activated if TIBCO 
BusinessConnect is to send any advisory messages during the processing of the 850 
transaction. 

The Error Advisory Processes folder contains the following processes:

• Ack Timeout Error Advisory Received

This process is activated when TIBCO BusinessConnect sends a timeout advisory due 
to not receiving a 997 acknowledgment for the original 850 transaction within the 
default timeout period of 1440 minutes (24 hours).

• General Error Advisory Received

This process is activated when TIBCO BusinessConnect sends a general error 
advisory. Several conditions which cause this advisory to be sent. For example, it is 
sent when an invalid message is sent from TIBCO ActiveMatrix BusinessWorks to 
TIBCO BusinessConnect. 
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For more information on when TIBCO BusinessConnect sends a general error 
advisory, refer to the TIBCO BusinessConnect EDI Protocol powered by Instream 
User’s Guide.

• Validation Error Advisory Received

This process is activated when TIBCO BusinessConnect sends an advisory indicating 
that a validation error occurred on the original 850 Transaction. 

Running the Tutorial

To run the tutorial, you must send the 850 transaction from TIBCO Designer and check 
the sending results.

1. Send the 850 transaction from TIBCO Designer. 

See Sending the 850 Transaction on page 32.

2. Check the results of sending the message. 

See Expected Results on page 34 and Viewing the Audit Log on page 35.

Sending the 850 Transaction

To see the 850 transaction, click X12 Message Processes > Send 850 Txn To BC in 
TIBCO Designer.

Figure 8 shows the Send 850 Txn to BC process.

Figure 8   Send 850 Txn to BC

The steps of how to load and run private processes in TIBCO Business Studio are similar 
to TIBCO Designer. See TIBCO ActiveMatrix BusinessWorks Documentation for more 
details.
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This process performs the following operations:

1. Reads a file containing XML data for a 850 transaction.

2. Parses the 850 XML data.

3. Constructs a message containing the 850 XML data, and sends it to TIBCO 
BusinessConnect EDI Protocol powered by Instream.

Running the Process

This procedure describes how to run the process.

1. In TIBCO Designer, click the Tester tab.

2. In the Tester tab, click Start testing viewed process .

Figure 9   Select Process to Load

3. In the Select Processes to Load dialog:

a. Select the check box next to Send 850 Txn To BC in the X12 Message Processes folder. 

b. Select the check boxes next to all three processes in the Error Advisory Processes folder.

4. Click Load Selected to run the process.

If everything is configured and runs properly, you can get the result shown in 
Figure 10, XML 850 Transaction Read from a File.
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Figure 10   XML 850 Transaction Read from a File

Expected Results

When the 850 transaction is received by TIBCO BusinessConnect EDI Protocol powered 
by Instream, several operations are performed.

1. TIBCO BusinessConnect EDI Protocol powered by Instream converts XML to X12 
data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against an 850 guideline.

3. The validated X12 data is bundled into an interchange for sending to the trading 
partner.

4. The X12 interchange is written to a file on the local file system when it simulates 
sending the interchange to the trading partner.

What you can observe:

• The Send 850 Txn activity of the Send 850 Txn To BC.process contains the output indicating 
that the 850 transaction is successfully sent to the trading partner.

• The c:\testEDI\out directory contains a file, which contains the X12 850 transaction that 
is sent to the trading partner by TIBCO BusinessConnect EDI Protocol powered by 
Instream.

• The audit log contains entries for each processing state that occurs in TIBCO 
BusinessConnect. For details, see Viewing the Audit Log on page 35.

• After 24 hours, TIBCO BusinessConnect EDI Protocol powered by Instream sends an 
acknowledgment timeout error advisory to TIBCO ActiveMatrix BusinessWorks. For 
this tutorial, it is not necessary to wait for this advisory message to arrive.
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Viewing the Audit Log

This procedure describes how to view the audit log on the Initiator machine.

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Log Viewer. 

3. In the right panel, click the X12 link.

4. Select items from the following lists: Status, Connection, and Date Range.

5. Click Search to search for the matching audit logs.

Figure 11   Send 850 Txn To BC Audit Log

6. Click Details  in the search results area for a specific operation to view details of 
the transaction.
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Figure 12   Transaction Details for the Send 850 Txn To BC Audit Log

7. Click  next to the specific transaction to see more details.

Figure 13   RECEIVED_FROM_PP
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The Detail View provides you with all message details. It also indicates whether a 
particular message can be resent or saved.

Retrieving the User Key for Outbound Documents

User key retrieval after the outbound documents are converted from XML to EDI is 
recorded in the row User Key: User Key: AB Purchase Order Number.
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Receive 850 TEXT Process

In this tutorial, you work with the Receive 850 TEXT Process that is located in the X12 

Message Processes folder.

This process receives a flat TEXT document for TIBCO BusinessConnect EDI Protocol 
powered by Instream based on the translation map that converts an X12 850 purchase 
order document into a TEXT document. You must ensure that the option "Parse XML 
output" is disabled during the EDI to TEXT conversion received by TIBCO ActiveMatrix 
BusinessWorks.

Prerequisites

Before running this tutorial, you must complete the tasks of Enabling Inbound File Poller 
and Setting Up the Monitor Directory.

Enabling Inbound File Poller

For this tutorial the Inbound File Poller must be configured and enabled. For more details, 
see TIBCO BusinessConnect Trading Partner Administration, Chapter 14, "File 
Transport, Inbound File Poller."

To enable and configure an inbound File poller on the TIBCO BusinessConnect server:

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > System Settings > Inbound Public 
Transport Types.

3. Select the check box next to the File transport.

4. Click Enable.

The enabled protocol is displayed with a red checkmark in the Enabled column.

Setting Up the Monitor Directory

To set up this directory, see TIBCO BusinessConnect Gateway Server Administration, 
Chapter 4, "Gateway Services, Poller Tab."

The directory to be monitored by the File Poller has to be set up. The directory must start 
with a forward slash (/), a back slash (\), two forward slashes (//), or [a-zA-Z]:, and must 
end with a forward slash (/) or a back slash (\). 

Example: C:\tibco\bc\version\monitorFiles
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Running the Tutorial

This section describes how to run the tutorial.

1. Receive a TEXT document based on the translation map for converting EDI to TEXT.

See Receiving the TEXT Document.

2. Check the results of sending the message. 

See Expected Results on page 40 and Viewing the Audit Log on page 40.

Receiving the TEXT Document

To see the 850 transaction, select X12 Message Processes > Receive 850 TEXT process.

The process is shown in Figure 14.

Figure 14   Receive 850 TEXT Process

Running the Process

This procedure describes how to run the process.

1. In TIBCO Designer, click the Tester tab.

2. In the Tester tab, click Start testing viewed process 

The steps of how to load and run private processes in TIBCO Business Studio are similar 
to TIBCO Designer. For more details, see TIBCO ActiveMatrix BusinessWorks 
Documentation.
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Figure 15   Select Process to Load

3. In the Select Processes to Load dialog:

a. Select the check box next to Receive 850 TEXT Process in the X12 Message Processes 
folder. 

b. Select the check boxes next to all three processes in the Error Advisory Processes folder.

4. Start the BusinessConnect engine and Gateway Server engine.

5. Drop the X12_4030_850.dat file (from the BC_HOME\protocols\tibedi\samples\sampleDocs 
directory) in the Inbound File Poller directory: 

C:\tibco\bc\version\monitorFiles

Expected Results

The Receive 850 TEXT process receives the converted FLAT file as a string data.

Viewing the Audit Log

This procedure describes how to view the audit log on the Initiator machine.

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Log Viewer. 

3. In the right panel, click the X12 link.

4. Select items from the following lists: Status, Connection, and Date Range.

5. Click Search to search for the matching audit logs.
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Figure 16   Receive 850 TEXT Process Audit Log

6. Click Details  in the search results area for a specific operation to view the details 
of the transaction.

Figure 17   Receive 850 TEXT Audit Log: Transaction Details
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CAQH Sample

TIBCO BusinessConnect EDI protocol powered by Instream supports CAQH 
connectivity rules, including Phase II (version 2.2.0) and Phase IV (version 4.0.0) of the 
CAQH connectivity rules. 

There are 2 type of envelope specifications - HTTP MIME Multipart and SOAP + WSDL. 
Phase II (version 2.2.0) connectivity rules support both envelopes, but Phase IV (version 
4.0.0) only support SOAP + WSDL envelope.

SOAP + WSDL Envelope

In this tutorial, you can use TIBCO ActiveMatrix BusinessWorks and TIBCO 
BusinessConnect EDI Protocol powered by Instream running on one machine to send an 
X12 270 batch transaction to a trading partner. 

The transaction set identifier information is as follows:

• Transaction set - 270

• Group version - 005010X279A1

• Interchange version - 00501

CAQH Batch Interaction

When you run the tutorial, the following operations occur at the Initiator end:

1. TIBCO Designer/TIBCO Business Studio reads an XML file, which contains the data 
for a 270 batch transaction.

TIBCO Designer/TIBCO Business Studio parses the XML data, and sends the XML 
data to TIBCO BusinessConnect EDI Protocol powered by Instream.

TIBCO BusinessConnect EDI Protocol powered by Instream converts the XML data 
to X12 data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against a 270 guideline. 

3. The validated X12 data is packaged with CAQH envelope and then bundled into a 
SOAP envelope for sending to the trading partner.

CAQH sample uses HIPAA operation and sample files and also uses SOAP protocol to 
package the CAQH message. You must install HIPAA and SOAP protocols before 
running the CAQH tutorial for sending and receiving CAQH message with SOAP + 
WSDL envelope.
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4. At the Responder end, the Response and Acknowledgments are generated and stored 
in the local file system and waiting for retrieval from the Initiator end.

5. The Initiator end, retrieves the response and acknowledgments.

6. The Initiator end generates Acknowledgment for the retrieved response and sends it 
back to the Responder end.

Processes Overview

Process names are slightly different in TIBCO Designer and TIBCO Business Studio. For 
example, the Send 270 Request to BC process in TIBCO Designer equals the 
Send_270_Request_to_BC process in TIBCO Business Studio. The following description takes 
processes in TIBCO Designer as an example.

The CAQH_SOAP_EDI project contains several processes in folders: Batch/Initiator/Explicit 

PayloadType Batch/CAQH_SOAP and Batch/Responder.

The Batch/Initiator/Explicit PayloadType Batch folder contains the following processes:

• Send 270 Request

This process reads a file containing the XML equivalent of a 270 transaction, and 
sends the XML data to TIBCO BusinessConnect as a CAQH batch submission 
request.

• Send 271 Response Retrieve Request

This process sends a CAQH batch response retrieval request to get the 271 response 
from the trading partner.

• Send 824 ACK Retrieve Request

This process sends a CAQH acknowledgment retrieval request to get the 824 
acknowledgment from the trading partner.

• Send 999 ACK Retrieve Request

This process sends a CAQH acknowledgment retrieval request to get the 999 
acknowledgment from the trading partner.

• Send TA1 ACK Retrieve Request

This process sends a CAQH acknowledgment retrieval request to get the TA1 
acknowledgment from the trading partner.

• Send 270 Request (Correlate PayloadID)

This process simulate Initiator send all CAQH request with the same PayloadID and 
expect that batch response/acknowledgment retrieval request only get data which is 
corresponding to the original batch request.

The Batch/Responder folder contains the following processes:
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• Receive 270 Request

This process receive batch submission 270 request and sends back 271 data as batch 
response.

Prerequisites

Before running this tutorial, you must complete the tasks of Importing Operations and 
Configuring Trading Partner and Host.

Importing Operations

You must import the following operations:

• Import CAQH operation of SOAP protocol.

BC_HOME/protocols/soap/samples/caqh/caqh.csx

• Import 270 sync request response operation of HIPAA protocol.

BC_HOME/protocols/tibedi/samples/interfaces/HIPAA-RT-00501-270-271.csx

Change the transaction name to 270R before importing 270 notify operations

a. Click the X12 link.

b. In the Edit Operations: X12 dialog, click the topmost expand all to display all 
operations.

c. Click 00501 > 005010X279A1 > 270 transaction link.

d. Click the Notification Transaction tab.

e. Click the General tab.

f. Change name property to 270R.

g. Click Save.

h. Click Done.

• Import 270 notify operations of HIPAA protocol.

BC_HOME/protocols/tibedi/samples/interfaces/HIPAA-00501.csx

Configuring Trading Partner and Host

You must do the following to configure the Trading Partner and Host. The below 
configuration is applicable both for the Initiator and Responder.

1. Click Partner > Protocols > SOAP > General tab.

2. On the General tab, select the Send CAQH Message To EDI Protocol check box.

3. Click Host > Protocols > X12 > General tab.
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4. In the CAQH UserName to authenticate at Partner field, enter Test.

5. In the CAQH Password to authenticate at Partner field, enter Test.

6. Click Host > Protocols > X12 > Advanced tab.

7. Click CAQH > Store location and specify the file directory. 

8. Click System Settings > User Authentication Configuration.

9. Click the Add button.

10. Select BC Database.

11. Click OK and then click Done.

12. Click User Management > Users > External tab.

13. Click the Add button.

14. In the Email field, enter Test.

15. From the Belongs to Partner list, select Trading Partner.

16. Set Password to Test.

17. Click OK and then click Save.

Running a Tutorial

To run the tutorial, you must run the following processes from TIBCO Designer and check 
the results.

• First, from the Responder side: 

Start Receive 270 Request process.

• Then, from the Initiator side run the following processes in the sequence shown 
below:

— Send 270 Request

— Send TA1 ACK Retrieve Request

— Send 999 ACK Retrieve Request

— Send 824 ACK Retrieve Request

— Send 271 Response Retrieve Request

Send a 270 Request transaction from TIBCO Designer.

See Sending the 270 Request.

• Check the results of sending the message. 

See Expected Results and Viewing the Audit Log.
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Sending the 270 Request

You must send a 270 Request from TIBCO Designer. This transaction is used for sending 
the CAQH batch submission request.

To see the Send 270 Request, click Project > Batch > Initiator > Explicit PayloadType 
Batch > CAQH_SOAP > Send 270 Request.

Send 270 Request shows the Send 270 Request to BC process.

Figure 18   Send 270 Request

This process performs the following operations:

1. Reads a file containing XML data for a 270 transaction.

2. Parses the 270 XML data.

3. Constructs a message containing the 270 XML data, and sends it to TIBCO 
BusinessConnect EDI Protocol powered by Instream.

Running the Process

This procedure describes how to run the process.

1. In TIBCO Designer, click the Tester tab.

2. In the Tester tab, click Start testing viewed process .
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Figure 19   Select Process to Load

3. In the Select Processes to Load dialog, select the check box next to Send 270 
Request To BC in the X12 Message Processes folder. 

4. Click Load Selected to run the process.

If everything is configured and runs properly, you can get the result shown in XML 
270 Transaction Read from a File.

Figure 20   XML 270 Transaction Read from a File

Expected Results

When the 270 transaction is received by TIBCO BusinessConnect EDI Protocol powered 
by Instream, several operations are performed.

1. TIBCO BusinessConnect EDI Protocol powered by Instream converts XML to X12 
data.
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2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against an 270 guideline.

3. The validated X12 data is packaged with CAQH envelope and then bundled into a 
SOAP envelope for sending to the trading partner.

4. At the Responder end, the Response and Acknowledgments are generated and stored 
in the local file system and waiting for retrieval from the Initiator end.

5. The Initiator end, retrieves the response and acknowledgments.

6. The Initiator end generates Acknowledgment for the retrieved response and sends it 
back to the Responder end.

What you can observe:

• The audit log contains entries for each processing state that occurs in TIBCO 
BusinessConnect. For details, see Viewing the Audit Log.

Viewing the Audit Log

This procedure describes how to view the audit log on the Initiator machine.

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Log Viewer.

3. Do one of the following:

— In the right panel, click the X12 link to view the X12 logs.

— In the right panel, click the SOAP link to view the SOAP logs.

4. Select items from the following lists: Status, Connection, and Date Range.

5. Click Search to search for the matching audit logs.
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Figure 21   Send 270 Request To BC X12 Audit Log at the Initiator end

Figure 22   Send 270 Request To BC SOAP Audit Log at the Initiator end
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Figure 23   Send 270 Request To BC X12 Audit Log at the Responder end

Figure 24   Send 270 Request To BC SOAP Audit Log at the Responder end

6. Click Details  in the search results area for a specific operation to view details of 
the transaction.
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Figure 25   Transaction Details for the Send 270 Request To BC X12 Audit Log

7. Click  next to the specific transaction to see more details.

Figure 26   Detailed View of Transaction at RECEIVED_FROM_PP state
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The Detail View provides you with all message details. It also indicates whether a 
particular message can be resent or saved.

CAQH Real-time Interaction

When you run the tutorial, the following operations occur:

1. TIBCO Designer/TIBCO Business Studio reads an XML file, which contains the data 
for a 270 transaction.
TIBCO Designer/TIBCO Business Studio parses the XML data, and sends the XML 
data to TIBCO BusinessConnect EDI Protocol powered by Instream.
TIBCO BusinessConnect EDI Protocol powered by Instream converts the XML data 
to X12 data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against a 270 guideline.

3. The validated X12 data is packaged with CAQH envelope and then bundled into a 
SOAP envelope for sending to the trading partner.

4. At the responder end, SOAP protocol unpacks the SOAP message, extracts the CAQH 
message, and then sends it to X12 protocol. X12 protocol validates the EDI data, 
converts it to an XML request, and then sends it to PP.

5. Responder PP sends back XML response, which contains the data for a 271 response, 
to Responder X12 protocol. X12 protocol converts the XML response to X12 data and 
validates it. After that, X12 data is packaged with CAQH envelope and forwarded to 
SOAP protocol for sending back to Initiator BC through the same HTTP 
communication channel.

6. Initiator SOAP protocol extracts the CAQH message and sends to X12 protocol. X12 
protocol extracts the response data, validates and converts it to XML response, and 
then sends it back to Initiator PP.

Process Overview

Process names are slightly different in TIBCO Designer and TIBCO Business Studio. For 
example, the Send 270 Request to BC process in TIBCO Designer equals the 
Send_270_Request_to_BC process in TIBCO Business Studio. The following description takes 
processes in TIBCO Designer as an example.

The CAQH_SOAP_EDI project contains several processes in folders: Realtime/Initiator and 

Realtime/Responder.

The Realtime/Initiator/V220 folder contains the following processes:

• Send 270 Request
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This process reads a file containing the XML equivalent of a 270 transaction, and sends 
the XML data to TIBCO BusinessConnect as a CAQH batch submission request of 
CAQH Phase II.

The Realtime/Initiator/V400 folder contains the following processes:

• Send 270 Request

This process reads a file containing the XML equivalent of a 270 transaction, and sends 
the XML data to TIBCO BusinessConnect as a CAQH batch submission request of 
CAQH Phase IV.

The Realtime/Initiator folder contains the following processes:

• Receive EDI Advisory Sync Request to SOAP

This process receives the CAQH Advisory messages that has been sent to SOAP.

• Receive SOAP Advisory Sync Request to EDI

This process receives the CAQH Advisory messages that has been sent to EDI.

The Realtime/Responder folder contains the following processes:

• Receive 270 Request and send 271 Response.

This process receives the 270 Synchronous Request and sends back 271as a Synchronous 
Response to BC.

• Receive SOAP Advisory Sync Response to EDI

This process receives the CAQH Advisory messages that has been sent to EDI

• Receive EDI Advisory Sync Response to SOAP

This process receives the CAQH Advisory messages that has been sent to SOAP.

Prerequisites

Before running this tutorial, you must complete the tasks of Importing Operations and 
Configuring Trading Partner and Host that are specified in CAQH Batch Interactions.

Running the Tutorial

To run the tutorial, you must run the following processes from TIBCO Designer and check 
the results.

• First, from the Responder side: 

Start "Receive 270 Request and Send 271 Response" process.

Then, from the Initiator side run the following processes as shown below:

Start "Send 270 Sync Request" available in Realtime/Initiator/V220.
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



54 | Chapter 2  Tutorials — Getting Started
Send a 270 Sync Request transaction from TIBCO Designer.

See Send 270 Sync Request.

• Check the results of sending the message. 

See Expected Results and Viewing the Audit Log.

Send 270 Sync Request 

You must send a 270 Request from TIBCO Designer. This transaction is used for sending 
the CAQH real-time request.

To see the Send 270 Sync Request, click Project > Realtime > Initiator > V220 > Send 270 
Sync Request.

Figure 27 shows the Send 270 Request to BC process.

Figure 27   Send 270 Sync Request

This process performs the following operations:

1. Reads a file containing XML data for a 270 transaction.

2. Parses the 270 XML data.

3. Constructs a message containing the 270 XML data, and sends it to TIBCO 
BusinessConnect EDI Protocol powered by Instream.

Running the Process

This procedure describes how to run the process.

1. In TIBCO Designer, click the Tester tab.

2. In the Tester tab, click Start testing viewed process 
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Figure 28   Select process to Load

3. In the Select Processes to Load dialog, select the check box next to Send 270 Sync 
Request To BC in the X12 Message Processes folder. 

4. Click Load Selected to run the process.

If everything is configured and runs properly, you can get the result shown in Send 270 
Sync Transaction. 

Figure 29   Send 270 Sync Transaction 

Expected Results

When the 270 transaction is received by TIBCO BusinessConnect EDI Protocol powered 
by Instream, several operations are performed.

1. TIBCO BusinessConnect EDI Protocol powered by Instream converts XML to X12 
data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against an 270 guideline.

3. The validated X12 data is packaged with CAQH envelope and then bundled into a 
SOAP envelope for sending to the trading partner.
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4. At the Responder end, response will be generated and is sent back to Initiator BC.

5. At the Initiator BC, SOAP protocol unpacks the SOAP message, extracts the CAQH 
message, and then sends it to X12 protocol. X12 protocol validates the EDI data, 
converts it to an XML response, and then sends it to PP. 

Viewing the Audit Log

This procedure describes how to view the audit log on the Initiator machine.

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Log Viewer.

3. Do one of the following:

— In the right panel, click the X12 link to view the X12 logs.

— In the right panel, click the SOAP link to view the SOAP logs.

4. Select items from the following lists: Status, Connection, and Date Range.

5. Click Search to search for the matching audit logs.

Figure 30   Send 270 Sync Request to BC X12 Audit Log at Initiator

Figure 31   Send 270 Sync Request to BC SOAP Audit Log at Initiator

Figure 32   Send 270 Sync Request to BC X12 Audit Log at Responder

Figure 33   Send 270 Sync Request to BC SOAP Audit Log at Responder
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6. Click Details  in the search results area for a specific operation to view details of 
the transaction.

Figure 34   Transaction Details for Receive 270 Request at BC SOAP

Figure 35   Transaction Details for Receive 270 Request at BC X12

7. Click  next to the specific transaction to see more details.

Figure 36   SYNC_REQUEST_FROM_SOAP

HTTP MIME Multipart Envelope

In this tutorial, you can use TIBCO ActiveMatrix BusinessWorks and TIBCO 
BusinessConnect EDI Protocol powered by Instream running on one machine to send an 
X12 270 batch transaction to a trading partner.

The transaction set identifier information is as follows:

• Transaction set - 270

• Group version - 005010X279A1

• Interchange version - 00501

CAQH sample uses HIPAA operation and sample files to package the CAQH message. 
You must install HIPAA before running the CAQH tutorial for sending and receiving 
CAQH message with HTTP MIME Multipart envelope.
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CAQH Batch Interaction

When you run the tutorial, the following operations occur at the Initiator end:

1. TIBCO Designer/TIBCO Business Studio reads an XML file, which contains the data 
for a 270 batch transaction.

TIBCO Designer/TIBCO Business Studio parses the XML data, and sends the XML 
data to TIBCO BusinessConnect EDI Protocol powered by Instream. 

TIBCO BusinessConnect EDI Protocol powered by Instream converts the XML data 
to X12 data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against a 270 guideline.

3. The validated X12 data is packaged with HTTP MIME Multipart Envelope and send 
to the trading partner.

4. When the request is received by the Responder, Batch receipt confirmation is sent to 
Initiator from Responder.

5. The Responder generates and stores the Response and Acknowledgments in the local 
file system and waits for the initiator to retrieve them.

6. The Initiator end retrieves the response and acknowledgments.

7. The Initiator end generates Acknowledgment for the retrieved response and sends it 
back to the Responder end.

Processes Overview

Process names are slightly different in TIBCO Designer and TIBCO Business Studio. For 
example, the Send 270 Request to BC process in TIBCO Designer equals the 
Send_270_Request_to_BC process in TIBCO Business Studio. The following description takes 
processes in TIBCO Designer as an example.

The CAQH_SOAP_EDI project contains several processes in folders: Batch/Initiator/Explicit 

PayloadType Batch/CAQH_MIME and Batch/Responder.

The Batch/Initiator/Explicit PayloadType Batch folder contains the following processes:

• Send 270 Request

This process reads a file containing the XML equivalent of a 270 transaction, and 
sends the XML data to TIBCO BusinessConnect as a CAQH batch submission 
request.

• Send 271 Response Retrieve Request to EDI

This process sends a CAQH batch response retrieval request to get the 271 response 
from the trading partner.
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• Send 824 ACK Retrieve Request to EDI

This process sends a CAQH acknowledgment retrieval request to get the 824 
acknowledgment from the trading partner.

• Send 999 ACK Retrieve Request to EDI

This process sends a CAQH acknowledgment retrieval request to get the 999 
acknowledgment from the trading partner.

• Send TA1 ACK Retrieve Request to EDI

This process sends a CAQH acknowledgment retrieval request to get the TA1 
acknowledgment from the trading partner.

• Send 270 Request (Correlate PayloadID)

This process simulates Initiator and sends all CAQH requests with the same 
PayloadID and expects that batch response/acknowledgment retrieval request only get 
the data which is corresponding to the original batch request.The Batch/Responder folder 
contains the following processes:

• Receive 270 Request

This process receives batch submission 270 request and sends back 271 data as batch 
response.

Prerequisites 

Before running this tutorial, complete the tasks of Importing Operations and Configuring 
Trading Partner and Host that are specified in CAQH tutorial with SOAP+WSDL 
implementation.

• While performing tasks of Importing Operations, it is not necessary to import CAQH 
operation of SOAP protocol.

• While performing the tasks of Configuring Trading Partner and Host, it is not 
necessary to configure SOAP protocol settings for TP that are mentioned below.

— Click Partner > Protocols > SOAP > General tab.

— On the General tab, select the Send CAQH Message To EDI Protocol check box.

• To perform CAQH operations with HTTP MIME Multipart, it is required to configure 
Transport Settings for Trading Partner that are mentioned below.

— Click Partner> Protocols > X12 > Transports tab.

— Create HTTP/HTTPS outbound transport and provide the below query string in 
HTTP/HTTPS transport URL.
package = x12-caqh-mime
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For example:
server1.company.example.com:6700/X12?package=x12- caqh-mime 

— At Business Agreement level, select the primary outbound transport as 
HTTP/HTTPS in which the outbound transport URL contains the query string 
mentioned above. To do this, perform the steps mentioned below:
Click Business Agreements>X12>Transports.
Select HTTP/HTTPS as a Primary Transport in the Outbound Transport for 
Host.

Running a Tutorial

To run the tutorial, you must run the following processes from TIBCO Designer and check 
the sending results.

• First, from the Responder side: 

Start Receive 270 Request process.

• Then, from the Initiator side run the following processes in the sequence shown 
below:

— Send 270 Request

— Send TA1 ACK Retrieve Request to EDI

— Send 999 ACK Retrieve Request to EDI

— Send 824 ACK Retrieve Request to EDI

— Send 271 Response Retrieve Request to EDI

Send a 270 Request transaction from TIBCO Designer.

• Check the results of sending the message. 

Sending the 270 Request

You must send a 270 Request from TIBCO Designer. This transaction is used for sending 
the CAQH batch submission request.

To see the Send 270 Request, click Project > Batch > Initiator > Explicit PayloadType 
Batch > CAQH_MIME  > Send 270 Request.

Running the Process

This procedure describes how to run the process.

If the mentioned query string is not provided in the outbound HTTP URL, TIBCO 
BusinessConnect EDI protocol powered by Instream will package outbound CAQH 
message with SOAP + WSDL envelope.
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1. In TIBCO Designer, click the Tester tab.

2. In the Tester tab, click Start testing viewed process .

3. In the Select Processes to Load dialog, select the check box next to Send 270 
Request To BC in the X12 Message Processes folder. 

4. Click Load Selected to run the process.

Expected Results

When the 270 transaction is received by TIBCO BusinessConnect EDI Protocol powered 
by Instream, several operations are performed.

1. TIBCO BusinessConnect EDI Protocol powered by Instream converts XML to X12 
data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against 270 guideline.
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3. The validated X12 data is packaged with HTTP MIME Multipart envelope and sent to 
the trading partner.

4. When the request is received by the Responder, Batch receipt confirmation is sent to 
Initiator. 

5. The Responder generates and stores the Response and Acknowledgments in the local 
file system and waits for the initiator to retrieve them.

6. The Initiator end  retrieves the response and acknowledgments

7. The Initiator end generates Acknowledgment for the retrieved response and sends it 
back to the Responder end.

Viewing the Audit Log

This procedure describes how to view the audit log on the Initiator machine.

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Log Viewer.

3. In the right panel, click the X12 link to view the X12 logs.

4. Select items from the following lists: Status, Connection, and Date Range.

5. Click Search to search for the matching audit logs.

Figure 37   Send 270 Request To BC X12 Audit Log at the Initiator end

Figure 38   Send 270 Request To BC X12 Audit Log at the Responder end
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6. Click Details  in the search results area for a specific operation to view details of 
the transaction

Figure 39   Transaction Details for the Send 270 Request To BC X12 Audit Log

7. Click  next to the specific transaction to see more details.

CAQH Real-time Interaction

When you run the tutorial, the following operations occur:

1. TIBCO Designer/TIBCO Business Studio reads an XML file, which contains the data 
for a 270 transaction.

TIBCO Designer/TIBCO Business Studio parses the XML data, and sends the XML 
data to TIBCO BusinessConnect EDI Protocol powered by Instream. 

TIBCO BusinessConnect EDI Protocol powered by Instream converts the XML data 
to X12 data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against a 270 guideline.

3. The validated X12 data is packaged with HTTP MIME Multipart Envelope and send 
to the trading partner.

4. The responder PP will send 271 XML response back to responder X12 protocol, X12 
protocol will convert it to EDI data and packages with HTTP MIME Multipart 
envelope and sends back to Initiator BC.

5. The Initiator X12 protocol extracts the EDI response data from HTTP MIME 
Multipart message, validates and converts it to XML response, and then sends it back 
to Initiator PP.
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Process Overview

The process information is similar to Process Overview pertaining to Real-time 
Interaction with SOAP+WSDL tutorial.

Prerequisites

To run this tutorial, Prerequisites tasks are similar to Prerequisites section available in 
Batch Interaction with HTTP MIME Multipart.

Running a Tutorial

This tutorial is similar to Running the Tutorial section provided in the Real-time 
Interaction of CAQH with SOAP+WSDL.

Expected Results

When the 270 transaction is received by TIBCO BusinessConnect EDI Protocol powered 
by Instream, several operations are performed.

1. TIBCO BusinessConnect EDI Protocol powered by Instream converts XML to X12 
data.

2. TIBCO BusinessConnect EDI Protocol powered by Instream validates the X12 data 
against 270 guideline.

3. The validated X12 data is packaged with HTTP MIME Multipart envelope and sent to 
the trading partner.

4. The Responder PP generates 271 Response, packages with HTTP MIME Multipart 
envelope and sends back to Initiator.

5. Initiator BC X12 unpacks the HTTP MIME Multipart envelope message, extracts the 
EDI data, validates it, and converts EDI to XML, and sends XML to PP, or directly 
sends EDI to PP.

Viewing the Audit Logs

This procedure describes how to view the audit log on the Initiator machine.

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Log Viewer.

3. In the right panel, click the X12 link to view the X12 logs.

4. Select items from the following lists: Status, Connection, and Date Range.

5. Click Search to search for the matching audit logs
TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



CAQH Sample | 65
Figure 40   Send 270 as Sync Request to BC Audit Log at the Initiator

Figure 41   Receive 270 Sync Request and send271 Response Audit Log at Responder

6. Click Details  in the search results area for a specific operation to view details of 
the transaction

Figure 42   Transaction Details for Send 271 as a Synchronous Response at Responder

7. Click  next to the specific transaction to see more details.
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Chapter 3 Managing X12 Interchanges, Functional 
Groups, and Transactions

This chapter describes how to manage X12 interchanges, functional groups, and 
transactions.

Topics

• Overview, page 68

• Adding an Interchange Version, page 69

• Adding a Group Version to an Interchange Version, page 70

• Adding a Transaction to a Group Version, page 71

• Notification Transaction, page 72

• Synchronous Request Response Transaction, page 78

• Configuring Acknowledgments, page 90

• Configuring Validation Profile (.apf) Files, page 94

• Exporting Interchanges, Groups, and Transactions, page 100

• Importing an Interchange Version, page 101
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Overview

An X12 document includes three basic structures.

• Interchange 

• Functional group 

• Transaction 

For details about these structures, see Chapter 1, X12 Overview, page 1.

You can use the TIBCO BusinessConnect console to configure the guidelines. Once you 
have configured transactions in the Operations Editor, the transactions can be seen during 
the configuration of your trading partners. The transactions can be allowed or disallowed, 
or the guideline itself can be overridden for a particular trading partner, if necessary.

For more information, see Operation Bindings Tab on page 149.

T To properly mark the ISA, GS, and ST segments with a DSR mark, as required for proper 
acknowledgments generation, see the documentation provided with the EDISIM 
Standards Editor.
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Adding an Interchange Version

The first step in configuring an X12 transaction in the TIBCO BusinessConnect console is 
to add the interchange version.

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Operations Editor. 

3. In the right panel, click the X12 link.

4. Click New Interchange Version.

5. In the Name field, type a name that corresponds to the X12 interchange version 
number.

6. (Optional) Provide a description for the new interchange.

7. Specify the Error Limit setting to control the number of errors reported or audited at 
transaction, group or interchange level to avoid system overload.

The default Interchange Setting is set to 1000. Only up to 1000 errors are reported to 
the private process and audited. Any errors over that limit are not reported, but the 
acknowledgment 997 or 999 reports everything. 

Error Limit 0 means that no error limit is set.

8. Click Save to save the configurations.
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Adding a Group Version to an Interchange Version

After adding an interchange version, you have to add a group version to it.

To add a group version to an interchange version:

1. Click an interchange version radio button.

2. Click New Group Version.

3. Configure the options listed in Table 3.

4. Click Save to save the configurations.

Table 3   Group Version Fields

Field Descriptions

Name Specify a name that corresponds to the X12 standard version, release and subrelease, 
which are designated in the functional group header (GS) segment. For example, 004010 or 
004030.

If you are configuring an interchange acknowledgment segment (TA1), type EmptyGroup, 
and then proceed to the steps in Adding a Transaction to a Group Version on page 71. See 
the sample interchange BC_HOME\protocols\tibedi\samples\interfaces\X12-00403.csx.

Description (Optional) Provide a description for this group version.

Error Limit Specify a threshold to control the number of errors reported or audited at transaction, 
group or interchange level to avoid system overload. If you set Error Limit to 0, it means 
that no limit is imposed at this level.

Group Setting 997 and 999 reports all the errors though the default value is 100. Only up to 
100 errors are reported to the private process and audit logged.

Application Code

GS02 Sender The application sender code in the GS segment of an X12 document. This code identifies 
the party sending the X12 group. Codes are agreed upon between trading partners. 

GS03 Receiver The application receiver code in the GS segment of an X12 document. This code identifies 
the party sending the X12 group. Codes are agreed upon between trading partners. 

GS07 
Responsible 
Agency Code

Accept or change the GS07 Responsible Agency Code.
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Adding a Transaction to a Group Version

After configuring your interchange and group versions, you can add your X12 transaction. 

To add a transaction:

1. Click a group version radio button.

2. Click New Transaction.

3. Select one of the following items from the Transaction Type list:

— Notification

Continue with Notification Transaction on page 72.

— Sync RequestResponse

Continue with Synchronous Request Response Transaction on page 78.

4. Click OK.
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Notification Transaction

Notification transactions are asynchronous in nature: a transaction is sent to the trading 
partner, and the response from the trading partner is expected at some later time. 

Only Notify transactions are currently supported for NAESB; Synchronous Request 
Response transactions are not supported. See also NAESB, page 142.

• Notification Transaction Tab, page 72

• Outbound Action Tab, page 75

Notification Transaction Tab

This tab contains three subtabs.

• General Tab, page 72

• Guideline Tab, page 73

• Schema Tab, page 74

General Tab

In the General tab, you can configure general information for notification transactions.

The following table lists the fields in the General tab of the Notification Transaction tab:

Table 4   Notification Transaction: General Tab

Field Description

Name Specify a name for the transaction.

Description Provide a description for the transaction (optional)

Inbound 
Raw EDI Segments

Include in 
Private Process 
Request

Select this check box to include raw EDI message in the private process 
(RESPONDER.REQUEST) for this operation. 

This check box is unselected by default.

Include in 
Validation Error 
Advisory

Select this check box to include raw EDI messages in the Validation Error advisory.

This check box is selected by default.
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Guideline Tab

In the Guideline tab, you can configure guideline information for notification 
transactions.

The following table lists the fields in the Guideline tab of the Notification Transaction 
tab:

Extra 
Transaction Info

This text field is used to send any information to the private process at transaction level 
of RESPONDER.REQUEST message.

It can also be included in RESPONDER.INTERCHANGE and ValidationAlert advisory.

Table 4   Notification Transaction: General Tab (Cont’d)

Field Description

Table 5   Notification Transaction: Guideline Tab

Field Description

GS01 Functional 
Identifier Code 

The mandatory code of the message. Example: PO. 

Entering the GS01 functional identifier that is normally indicated in the 
Functional Group Header is needed by the EDI conversion engine.

Validation Guideline

Guideline File for 
validating X12 Partner 
data (.sef or .std)

The guideline file associated with this message type. It is used to validate the 
EDI document that is received from a trading partner, or that is sent to the 
trading partner.

Click change to select the guideline file associated with this message type. 
Then, follow the procedure described in the section File Specification Dialog in 
TIBCO BusinessConnect Trading Partner Administration Guide.

Validator Profile File 
(.apf)

Click change to select and load the Validator profile file. 

Validator profile files are used to check on errors and categorize them to 
different levels of severity. For details, see Configuring Validation Profile (.apf) 
Files.

Error Limit Specify a threshold to control the number of errors reported or audited at 
transaction, group or interchange level to avoid system overload. If you set 
Error Limit to 0, it means that no limit is imposed at this level.

The default transaction setting is 10. Only up to 10 errors are reported per 
transaction, both in the audit and ERROR.VALIDATION. However, 
acknowledgments have all the errors that are being reported.
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Schema Tab

In the Schema tab, you can configure schema information for notification transactions.

The following table lists the fields in the Schema tab of the Notification Transaction tab:

Inbound
Type of Translation

Inbound X12 
Translation Type (e.g. 
EDI to XML or EDI to 
TEXT)

Select one item from the list to specify the inbound X12 translation type.

• EDI to XML This is the default value.

When you select EDI to XML from the list, the inbound X12 document is 
translated to XML. It can be overridden at the business agreement level to 
do EDI to TEXT translation. For more details, see Table 33, Override 
Settings for Notify: Guideline.

• EDI to TEXT  When you select EDI to TEXT from the list, the Inbound 
X12 document is translated into a TEXT document, depending on the 
structure of the guideline that is designed. When a proper TEXT guideline is 
uploaded and an appropriate translation map for mapping EDI to TEXT is 
created, the output is a TEXT file.

TEXT Translation Guideline

Guideline File used for 
translating X12 to 
TEXT (.sef or .std)

Click change to select a guideline file for translating X12 to TEXT. 

This TEXT guideline is used for translating an X12 EDI document into a TEXT 
document.

Table 5   Notification Transaction: Guideline Tab (Cont’d)

Field Description

Table 6   Notification Transaction: Schema Tab

Field Description

Transaction 
Schema (.xsd)

Click change to select the schema file associated with this message type. 

The message schema is required for the EDI conversion engine. When a connection to 
TIBCO BusinessConnect is created in TIBCO Designer or TIBCO Business Studio, 
loading the message schema into the TIBCO BusinessConnect configuration store 
allows it to be retrieved automatically by TIBCO Designer or TIBCO Business Studio.

Request Root 
Element Name

Specify the name of the Transaction Schema root element from the preceding field.
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Outbound Action Tab

To configure the outbound action for the Notification transaction, you must configure 
information in the subtabs of the Outbound Action tab.

• General Tab, page 75

• Batching Tab, page 75

• Acknowledgement Tab, page 76

General Tab

In the General tab, you can configure general information for outbound actions.

The following table lists the fields in the General tab of the Outbound Action tab:

Batching Tab

In the Batching tab, you can configure batching information for outbound actions.

EDI to XML (or 
EDI to TEXT) 
Translation Map 
file (.map)

Click change to select the EDI to XML or EDI to TEXT translation map file associated 
with this message type. 

• If you select EDI to TEXT as the type of translation, the appropriate X12 to TEXT 
translation map must be uploaded for the translation to occur. 

• If you select EDI to XML as the inbound type of translation, the appropriate X12 to 
XML translation map must be uploaded for the translation to occur.

Note that EDI to XML translation map files generally have the extension _EX.map.

XML to EDI 
Translation Map 
file (.map)

Click change to select the XML to EDI translation map file associated with this message 
type. Note that XML to EDI translation map files have the extension _XE.map.

Table 6   Notification Transaction: Schema Tab

Field Description

Table 7   Outbound Action: General Tab

Field Description

Name Specify a name for the outbound action.

Description Provide a description for the outbound action.

Direction Specify the Initiator to Responder (pre-filled).
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The following table lists the fields in the Batching tab of the Outbound Action tab: 

Acknowledgement Tab

In the Acknowledgement tab, you can configure acknowledgment information for 
outbound actions.

Table 8   Outbound Action: Batching Tab

Field Description

Batch Option Select one item from the Batch Option list:

• Always This is the default option.

If Scheduled Transmission is enabled in the Scheduled Transmission tab of a 
trading partner's business agreement with the host, all messages of this transaction 
type for that trading partner are placed into batches. The batches are sent based upon 
the settings in the Scheduled Transmission tab of the business agreement. See 
Scheduled Transmission Tab on page 170.

• Never Messages of this transaction type are not to be included in any batches 
regardless of whether the scheduled transmission has been enabled for a trading 
partner. All messages of this type are sent immediately to your trading partners, and 
bypass the schedule time/batch settings for your trading partners.

• Exclusively When messages of this transaction type are included in a scheduled 
batch, they are separated into interchanges containing only messages of this type. 
With this choice, you can batch transactions based upon transaction type. 

For example, you can batch all 850 transactions and all 860 transactions so that your 
trading partners receive 850 transactions in one interchange and 860 transactions in 
another interchange. The exclusive batching feature includes two options where 
TIBCO BusinessConnect can transmit:

— Each interchange in its own document.

— Multiple interchanges in a single document.
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The following table lists the fields in the Acknowledgement tab of the Outbound Action 
tab:

For information on configuring acknowledgments, see TIBCO BusinessConnect EDI 
Protocol powered by Instream User’s Guide, Chapter 5, "Acknowledgments and 
Reconciliation."

Table 9   Outbound Action: Acknowledgement Tab

Field Description

Maximum Wait 
(minutes)

The default waiting time is 1440 minutes.

This is the maximum amount of time that TIBCO BusinessConnect waits for an 
acknowledgment (997 functional acknowledgment transaction) from your trading 
partner when a message of this type is sent to your trading partner. 

If an acknowledgment is not received within the time limit specified, TIBCO 
BusinessConnect logs an ACK_RESPONSE_TIMEOUT state for the original message, and 
sends an alert message on the subject prefix.installation.X12.ERROR.TIMEOUT.ACK to the 
private process.

Reconcile After 
Timeout

Acknowledgments that are received after the timeout period are reconciled and 
processing of the original message continues. 

Normally when an acknowledgment times out, the final status of the original message 
is set to ACK TIMEOUT ERROR. If the acknowledgment is received after the timeout 
period, it is ignored.

Mark as 
Completed After 
Timeout

Final status of Completed with a state of ACK_RESPONSE_TIMEOUT is logged for the original 
message in the case when the acknowledgment for the message is not received before 
the specified timeout. If you select this check box and the acknowledgment is received 
after the timeout, it is ignored.

This feature is useful when your trading partner is sending an acknowledgment only 
when validation errors occur for the original message. After the acknowledgment 
timeout period expires, the original message is assumed to be accepted by your trading 
partner.
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Synchronous Request Response Transaction

Synchronous request-response transactions are transactions where a response transaction 
is expected to be returned quickly and using the same transport connection as the request 
transaction. In case of validation errors, the normal response cannot be returned but 
another transaction, for example, 997 or TA, is returned indicating that validation errors 
occur.

For example, you can agree with your trading partner that each 850 purchase order 
transaction you send must have an 855 purchase order acknowledgment transaction 
returned as a response on the same transport connection. If a validation error occurs in the 
850 purchase order transaction, an 855 response cannot be returned. Instead, a 997 
response is returned, indicating that the 850 is rejected. You do not usually choose to keep 
a transport connection open for more than a minute or two. Therefore, the time frame, 
which the response is expected within, must be fairly short. Synchronous request-response 
transactions are only supported on those transports for which a response transaction can be 
returned on the same connection used for sending the request transaction.

Synchronous Request and Notify Operations

Users receiving a synchronous request from their trading partner can also receive a notify 
operation of the same transaction type under the same group and interchange. 

This result can be achieved by having a mandatory business agreement with the trading 
partner and configuring the following information:

• Naming the synchronous request operation of the transaction 101, so that it ends with 
R, for example, 101R.

• Configuring the trading partner to send the GS02 Sender Application ending with R. 
Then, the receiving BusinessConnect can detect the operation as a synchronous 
transaction and to trade synchronously with their partner. If either one of the preceding 
two configurations is missing and two different operation types are configured, 
namely synchronous (101R) and notify operations (101) for the same transaction type, 
the receiver always receives the transaction as a notify transaction even though the 
initiator might have sent it in synchronous mode.

Default Response for a Synchronous Request

You can send a default response for a synchronous request in case the response from the 
private process on the responder side fails due to validation errors. 

Synchronous Request-Response transactions are applicable only to the HTTP transport.
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To configure the default response, upload this response file to the following location:

BusinessAgreement>X12>Partner can initiate>operation>Action Settings> Default response

The Default Response field is available only in the Partner can initiate field of the 
operation binding. It is configurable to send a templated response to the trading partner if 
the synchronous response sent from the private process contains any validation errors or 
errors in the response XML. In such case, this templated response is sent back to the 
trading partner with no validation or syntax check. Users have to ensure that the Default 
Response is a valid response.

For more information on synchronous request-response transactions, see TIBCO 
BusinessConnect EDI Protocol powered by Instream User’s Guide, Chapter 8, "Private 
Messages."

Configuring the Synchronous Request Response Transaction

To configure the synchronous request response transaction, configure corresponding 
information in the following tabs, and then click Save to save the configurations.

• General Tab, page 79

• Request Action Tab, page 85

• Response Action Tab, page 87

General Tab

In the General tab, you can configure general information for synchronous request 
response transactions.

The following table lists the fields in the General tab:

Table 10   Synchronous Request Response Transaction: General tab

Field Description

Name Specify a name for the transaction. Example: 850.

Description (Optional) Provide a description for the transaction.

Transaction Type

Acceptance Response Specify an acceptance response transaction type. 

This is the type of transaction expected as a response from your trading partner. 
For example, if 850 is the request transaction, the acceptance response transaction 
type is 855.
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Guideline Tab

In the Guideline tab, you can configure guideline information for synchronous request 
response transactions.

The following table lists the fields in the Guideline tab

Rejection Ack Specify a rejection acknowledgment transaction type. 

This field indicates the type of transaction that is expected to be returned as a 
response if the original request transaction has validation errors.

The default type is 997.

Inbound 
Raw EDI Segments

Include in Private 
Process Request

Select this check box to include raw EDI message in the private process 
(RESPONDER.REQUEST) for this operation. 

This check box is cleared by default.

Include in Validation 
Error Advisory

Select this check box to include raw EDI messages in the Validation Error 
advisory.

This check box is selected by default.

Table 10   Synchronous Request Response Transaction: General tab (Cont’d)

Field Description

Table 11   Synchronous Request Response Transaction: Guideline Tab (Sheet 1 of 5)

Field Description

Request

GS01 Functional Identifier 
Code (for Request)

Specify the mandatory functional identifier code of the transaction. Entering 
the GS01 functional identifier, which is normally indicated in the Functional 
Group Header, is required by the EDI conversion engine.

Examples:

• Request PO for an 850 purchase order transaction.

• Acceptance Response PR for an 855 purchase order acknowledgment 
transaction.

• Rejection Acknowledgment FA for a 997 functional acknowledgment 
transaction.
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Type of Translation

Inbound Translation Type 
(e.g. EDI to XML or EDI to 
TEXT)

Select one item from the list to specify the inbound translation type.

• EDI to XML This is the default value.

When you select EDI to XML from the list, the inbound Synchronous 
X12 document is translated to XML. It can be overridden at the business 
agreement level to do EDI to TEXT translation. For details, see 
Table 33, Override Settings for Notify: Guideline.

• EDI to TEXT  When you select EDI to TEXT from the list, the 
appropriate synchronous X12 document is translated to TEXT. 

When a proper TEXT guideline is uploaded and an appropriate 
translation map for mapping EDI to TEXT is created, the output is a 
TEXT file.

X12 Validation Guideline for Request

Request Guidelines File (.sef 
or .std)

Provide the path to the inbound synchronous request guidelines file. You can 
override this field at the business agreement level. You can use this guideline 
file to validate the EDI document that is received from a trading partner or 
sent to a trading partner.

Click change to select a .sef or .std guideline file.

Request Validator Profile 
File (.apf)

Provide the path to the inbound synchronous request Validator Profile file 
that you want to suppress errors into warning or information. You can 
override this field at the business agreement level.

Click change to select and load the Validator Profile file (.apf).

TEXT Translation Guideline

Guideline File used to 
translate X12 to TEXT (.sef 
or .std)

Click change to select a guideline file to translate X12 to TEXT. 

This TEXT guideline is used for translating an X12 EDI document into a 
TEXT document.

Table 11   Synchronous Request Response Transaction: Guideline Tab (Sheet 2 of 5)

Field Description
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Request Error Limit Specify a threshold to control the number of errors reported or audited at 
transaction, group or interchange level to avoid system overload. If you set 
Request Error Limit to 0, it means that no limit is imposed at this level.

The default value is 10. Only up to 10 errors are reported per transaction, 
both in the audit and ERROR.VALIDATION. However, acknowledgments 
have all the errors that are being reported.

Acceptance Response

GS01 Functional Identifier 
Code (for Response)

Specify the mandatory functional identifier code of the transaction. Entering 
the GS01 functional identifier, which is normally indicated in the Functional 
Group Header, is required by the EDI conversion engine.

Examples:

• Request PO for an 850 purchase order transaction.

• Acceptance Response PR for an 855 purchase order acknowledgment 
transaction.

• Rejection Acknowledgment FA for a 997 functional acknowledgment 
transaction.

X12 Validation Guideline for Response

Response Guidelines File 
(.sef or .std)

Provide the path to the outbound synchronous response Guidelines file. You 
can override this field at the business agreement level. 

This guideline file is used to validate the synchronous response EDI 
document that is received from a trading partner, or that is sent to a trading 
partner.

Click change to select and load the .sef or .std Guidelines File.

Response Validator Profile 
File (.apf)

Provide the path to the outbound synchronous response Validator Profile file 
that you want to suppress errors into warning or informational if the 
responses have errors. You can override this field at the business agreement 
level.

Click change to select and load the Validator Profile File (.apf).

TEXT Translation Guideline

Table 11   Synchronous Request Response Transaction: Guideline Tab (Sheet 3 of 5)

Field Description
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Guideline File used to 
translate EDI response to 
TEXT (.sef or .std)

Click change to select a guideline file for translating EDI to TEXT.

This TEXT guideline is used to translate a synchronous X12 response EDI 
document into a TEXT document.

Type of Translation

Backend to Partner 
Translation type for 
Response (e.g. XML to EDI 
or TEXT to EDI)

• XML to EDI

• TEXT to EDI  TEXT data can be sent from the private process, 
converted to the EDI data, and sent back to the Initiator.

For more details, see TIBCO BusinessConnect EDI Protocol powered by 
Instream User’s Guide, "TEXT to EDI Conversion."

TEXT Translation Guideline

Guideline File used to 
translate TEXT to EDI 
response (.sef or .std)

Click change to select and load a guideline file for translating TEXT to EDI.

This TEXT guideline is used for translating a TEXT document into 
synchronous X12 response EDI document.

Response Error Limit Specify a threshold to control the number of errors reported or audited at 
transaction, group or interchange level to avoid system overload. If you set 
Request Error Limit to 0, it means that no limit is imposed at this level.

The default value is 10. Only up to 10 errors are reported per transaction, 
both in the audit and ERROR.VALIDATION. However, acknowledgments 
have all the errors that are being reported.

Rejection Ack

GS01 Functional Identifier 
Code (for 
Acknowledgement)

Specify the mandatory code of the acknowledgment. Example: FA. 

Entering the GS01 functional identifier, which is normally indicated in the 
Functional Group Header, is required by the EDI conversion engine.

Rejection Ack Guidelines 
File (.sef or .std)

Provide the path to the Rejection Ack Guidelines file. You can override this 
field at the business agreement level.

Click change to select and load the Rejection Ack Guidelines File (.sef or 
.std).

This guideline file is used to validate the synchronous EDI rejection 
acknowledgment document that is received from a trading partner, or that is 
sent to a trading partner.

Table 11   Synchronous Request Response Transaction: Guideline Tab (Sheet 4 of 5)

Field Description
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Schema Tab

In the Schema tab, you can configure schema information for synchronous request 
response transactions.

Loading the transaction schemas into the TIBCO BusinessConnect configuration store 
allows it to be retrieved automatically by TIBCO Designer or TIBCO Business Studio 
when a connection to TIBCO BusinessConnect is created in TIBCO Designer or TIBCO 
Business Studio. For further information, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "Creating Private Processes."

The following table lists the fields in the Schema tab:

Inbound Translation Guideline for Rejection Ack

Guideline File used to 
translate EDI rejection Ack 
to TEXT (.sef or .std)

Click change to select and load a guideline file for translating EDI rejection 
Ack to TEXT.

This TEXT guideline is used for translating a synchronous X12 rejection 
acknowledgment EDI document into a TEXT document.

Table 11   Synchronous Request Response Transaction: Guideline Tab (Sheet 5 of 5)

Field Description

Table 12   Synchronous Request Response Transaction: Schema Tab

Field Description

Request

Request Transaction 
Schema (.xsd)

To load the synchronous Request Transaction schema, click change to select the 
schema file for the synchronous request transaction.

Example: X12_5010_850.xsd.

Request Root Element 
Name

Specify the name of the root element of the synchronous request Transaction 
Schema from the above field.

Acceptance Response

Response Transaction 
Schema (.xsd)

To load the synchronous Response Transaction schema, click change to select the 
schema file for the synchronous response transaction.

Example: X12_5010_850.xsd.

Response Root 
Element Name

Specify the name of the root element of the synchronous response Transaction 
Schema from the preceding field.
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Request Action Tab

To configure request actions for synchronous request response transactions, you have to 
configure information in the subtabs of the Request Action tab.

General Tab

In the General tab, you can configure general information for request actions.

The following table lists the fields in the General tab of the Request Action tab: 

Translation Map Tab

In the Translation Map tab, you can configure translation map information for request 
actions.

Rejection Ack

Rejection Ack 
Transaction Schema 
(.xsd)

To load the Rejection Ack Transaction schema, and click change to select the 
schema file for the rejection acknowledgment transaction.

Example: X12_5010_997.xsd.

Rejection Root 
Element Name

Specify the name of the root element of the Transaction Schema from the 
preceding field.

Table 12   Synchronous Request Response Transaction: Schema Tab

Field Description

Table 13   Request Action: General Tab

Field Description

Name Specify the name of a request action.

Description Provide a description for this action.

Direction Specify the Initiator to Responder (pre-filled).

Time to Wait for 
Sync Response 
(seconds)

Specify the time for TIBCO BusinessConnect to wait for a synchronous response 
from a trading partner before it closes the connection of the HTTP socket.

The default value is 60.
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The following table lists the fields in the Translation Map tab of the Request Action tab: 

Table 14   Request Action: Translation Map Tab

Field Description

Request

Request XML to EDI 
Translation Map File (.map)

Click change to select the XML to EDI translation map file. This file is 
associated with this message type for sending XML from the private 
process to TIBCO BusinessConnect and is sent to the Trading Partner as a 
synchronous request.

Note that XML to EDI translation map files have the extension _XE.

Acceptance Response

Response EDI to XML (or 
EDI to TEXT) Translation 
Map File (.map)

Click change to select the EDI to XML or EDI to TEXT translation map 
file.

• If you select EDI to TEXT as the inbound type of translation, the 
appropriate X12 to TEXT translation map must be uploaded for the 
translation to occur.

• If you select EDI to XML as the inbound type of translation, the 
appropriate X12 to XML translation map must be uploaded for the 
translation to occur.

Note that EDI to XML translation map files have the extension 
_EX.map.

Rejection Ack

Rejection Ack EDI to XML 
(or EDI to TEXT) Translation 
Map File (.map)

Click change to select the EDI to XML or EDI to TEXT translation map 
file. 

• If you select EDI to TEXT as the inbound Type of Translation, then 
the appropriate X12 to TEXT translation map must be uploaded for 
the translation to occur.

• If you select EDI to XML as the inbound Type of Translation, then the 
appropriate X12 to XML translation map must be uploaded for the 
translation to occur.

Note that EDI to XML translation map files have the extension 
_EX.map.
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Response Action Tab

To configure request actions for synchronous request response transactions, you have to 
configure information in the subtabs of the Response Action tab.

General Tab

In the General tab, you can configure translation map information for response actions.

The following table lists the fields in the General tab of the Response Action tab:

Translation Map Tab

In the Translation Map tab, you can configure translation map information for request 
actions.

The following table lists the fields in the Translation Map tab of the Response Action 
tab:

Table 15   Response Action: General Tab

Field Description

Name Specify the name of a response action. 

Description Provide a description for this action.

Direction Specify the Responder to Initiator (pre-filled).

Time to Wait for PP 
Response (seconds)

Specify the amount of time for the Responder BusinessConnect to wait after the 
synchronous request is sent to the private process. If the response is not received, a 
timeout occurs, an error is logged, and the error response is sent to the trading 
partner. If the response is received within the defined amount of time, the response 
is sent back to the partner.

The default value is 60.

Table 16   Response Action: Translation Map Tab

Field Description

Request
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Request EDI to XML (or 
EDI to TEXT) Translation 
Map File (.map)

Click change to select and load the EDI to XML (or EDI to TEXT) translation 
map file. 

• If you select EDI to TEXT as the inbound type of translation, the 
appropriate X12 to TEXT translation map must be uploaded for the 
translation to occur.

• If you select EDI to XML as the inbound type of translation, the 
appropriate X12 to XML translation map must be uploaded for the 
translation to occur.

Note that EDI to XML translation map files have the extension _EX.map.

Table 16   Response Action: Translation Map Tab (Cont’d)

Field Description
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Acceptance Response

Response XML to EDI (or 
TEXT to EDI) translation 
Map File (.map)

Click change to select the XML to EDI (TEXT to EDI) translation map file. 
This file is associated with this message type for sending the synchronous 
response to a trading partner that is received from the private process.

Note that XML to EDI translation map files have the extension _XE.map.

For TEXT to EDI translations, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "TEXT to EDI Conversion."

Table 16   Response Action: Translation Map Tab (Cont’d)

Field Description
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Configuring Acknowledgments

This section describes how to configure acknowledgments. 

Configuring 997 Functional Acknowledgments

The 997 transaction set is also called a functional acknowledgment. 

It is used to indicate the results of the syntactical analysis of a same type transaction 
group, such as all 850 transactions contained in the same functional group inside an 
interchange. If functional acknowledgments (997s) are to be sent or received for X12 
transaction sets, you must configure a 997 transaction for each functional group 
containing the transaction sets. 

For example, the sample interchange X12-00403.csx contains the following information:

00403 interchange version
005010 group version

850 transaction set
997 transaction set

You can configure the 997 transaction set in the Operations Editor just as you configure 
any other X12 transaction set. However, for the 997 transaction set it is not necessary to 
upload the guideline to use for validation. 

TIBCO BusinessConnect EDI Protocol powered by Instream contains a generic 997 
guideline, which is used by default. The generic 997 guideline X12_5010_997.sef can be found 
in the directory: BC_HOME\protocols\tibedi\samples\sampleDocs\guidelines.

Configuring the 999 Implementation Acknowledgments

The 999 implementation acknowledgments are used to report the status of implementation 
guide syntax edits. Automatic generation of the 999 acknowledgment is available for 
transactions in group 004061 and higher.

Configuration of the 999 implementation acknowledgment is similar to configuring a 997 
acknowledgment: you can configure the 999 as a transaction set in the operations editor 
just as you configure a 997. 

T To properly mark the ISA, GS, and ST segments with a DSR mark, as required for proper 
acknowledgments generation, see the documentation provided with the EDISIM 
Standards Editor.

The 997 transactions are not sent as acknowledgments for other 997 transactions.
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For example, to use a 999 acknowledgment instead of a 997 acknowledgment in the 
X12-00403.csx example interface, you can replace the configuration of the 997 
acknowledgment with a configuration for the 999 acknowledgment as follows:

00403 interchange version
005010 group version
850 transaction set
999 transaction set

When configuring the 999 transaction set in the Operations Editor, it is not necessary to 
upload the guideline for 999. TIBCO BusinessConnect EDI Protocol powered by Instream 
contains a generic 999 guideline, which is used whenever the configuration of a 999 
transaction set does not have a guideline uploaded. The generic 999 guideline for the 
preceding example is X12_5010_999.sef, and can be found in the directory: 
BC_HOME/protocols/tibedi/samples/sampleDocs/guidelines.

Configuring TA1 Interchange Acknowledgment Segments

The interchange acknowledgment segment (TA1) is used to indicate the receipt of the 
contents of one interchange control header and trailer envelope, in which the envelope 
surrounds one or more functional groups. If the interchange contains only TA1 segments, 
a TA1 is not returned for the interchange.

If interchange acknowledgment segments are sent or received for interchanges containing 
X12 transaction sets, you must configure a TA1 interchange segment for each interchange. 
You can configure the TA1 interchange segment with a guideline just as you configure any 
other X12 transaction set. However, since the TA1 is not really a transaction set and is 
never contained inside of a functional group, the TA1 interchange segment is configured 
inside of a group version named EmptyGroup.

For example, the sample interchange X12-00403.csx contains the following information:

00403 interchange version
005010 group version

850 transaction set
997 transaction set

EmptyGroup group version
TA1 interchange segment

The EmptyGroup group version is not configured with a guideline.

Similar to the 997, TIBCO BusinessConnect EDI Protocol powered by Instream contains 
a generic TA1 guideline, which it uses by default. Therefore, it is not necessary to upload 
a guideline for the TA1. The generic TA1 guideline X12_TA1.sef can be found in the 
directory: BC_HOME\protocols\tibedi\samples\sampleDocs\guidelines.
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Multiple Configurations for the Same Transaction Type

TIBCO BusinessConnect EDI Protocol powered by Instream provides a name modifiers 
feature that you might need to use to provide multiple configurations for your message. 
This feature is called Transaction Name Modifiers.

Transaction Name Modifiers 

The Transaction Name Modifiers are used to configure multiple guidelines for the same 
transaction type in cases when only certain trading partners are supported to use the 
alternate message configurations. 

With them, you can create multiple operation bindings for a single operation set, which 
then allows them to target otherwise identical transactions, such as a purchase order, to a 
specific departments belonging to a trading partner. The trading partner departments are 
allowed to do the same when sending transactions to your departments. 

You might need different guidelines for the same transaction type to satisfy the transaction 
exchange requirements for all of your trading partners. For example, the 850 guideline 
used for the trading partner A may include additional data elements which may not be 
suitable for other trading partners. These additional data elements may also generate an 
XSD for the guideline that is different from the XSD generated for the 850 guidelines that 
are used otherwise. To handle this situation, you can configure multiple versions of the 
same transaction type by using message name modifiers when configuring the transaction.

To use a Transaction Name Modifier:

1. Click Notification Transaction > General tab.

2. In the Name field, type the name of the transaction type. 

3. Append a colon (:) to the name.

4. Provide a short description after the colon to differentiate the transaction type 
configurations.

For example, you can configure two versions of a 00403 850 transaction as:

00403/005010/850

00403/005010/850:TPA

You must configure the generic 00403/005010/850 version to exchange any 850 purchase 
order transactions with your trading partners, including transaction for the trading 
partner for which you are using the modified version. In the preceding example, this is 
Trading Partner A, using the version 00403/005010/850:TPA.

One business agreement can have only one Transaction Name Modifier of the same 
transaction or message type.
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For the name modified version 00403/005010/850:TPA to be used for trading partner A, 
you must bind the name modified version 00403/005010/850:TPA to trading partner A.

For more information, see Operation Bindings Tab on page 149.

When an inbound 850 transaction is received for trading partner A, the guideline 
associated with the named modified version 00403/005010/850:TPA is used for validation of 
the message.

The operationID field of the ResponderRequest message to the private process contains the 
modified message name 00403/005010/850:TPA. With this transaction name, the private 
process can filter and handle this non-generic 850 message from trading partner A.

If the Transaction Name Modifier operation is not bound, the default operation without the 
modifier is picked by TIBCO BusinessConnect to validate transactions.
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Configuring Validation Profile (.apf) Files

By default, any validation error that occurs causes a transaction to be rejected. When a 
transaction is rejected, the 997 generated contains an AK5 segment with a Transaction Set 
Acknowledgment Code of 'R' for the transaction. When validating EDI transactions, it is 
desirable to be able to control whether a validation error causes the rejection of the entire 
transaction or not. 

Sometimes you might want the error reported and the transaction rejected. At other times, 
you might want to report the error in the 997 but to accept the transaction anyway. For 
example, the generated 997 has a Transaction Set Acknowledgment Code of 'E' for 
accepted with errors. You might want validation errors ignored altogether, or you might 
want only some validation errors ignored.

In conjunction with EDISIM Validator, TIBCO BusinessConnect EDI Protocol powered 
by Instream now provides the ability to configure the severity errors, which occur in EDI 
transactions.

Severity Level

When a transaction is rejected, the segments in the generated 997 acknowledgment looks 
something like the following information:

ST~997~0001'
AK1~HC~000000001'
AK2~837~000000001'
AK3~CLM~36~2300~8'
AK4~11+3~1362~1~AP'
AK5~R'
AK9~R~1~1~0'
SE~9~0001'

The AK2 segment identifies the transaction that is rejected. The AK3 and AK4 segments 
give information about where errors occur in the transaction. The AK5 segment indicates 
that the transaction rejected, and contains a transaction status code of 'R'. 

The AK9 segment indicates that the group is rejected, 'R', since only one transaction exists 
in the group and that transaction is rejected. If some of the transactions in the group are 
accepted while others are rejected, the status of the group in the AK9 segment is 'P', which 
indicates that at least one transaction in the group is rejected.

When a transaction type is rejected, error information is also sent to the private process on 
the subject AX.BC.BC instance name.X12.ERROR.VALIDATION. This error information contains 
the transaction ID of the transaction, which has validation errors and descriptive 
information about the validation errors.
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Setting different severity levels to validation errors affect the information about the 
validation errors that is contained in 997 acknowledgments and the error information 
reported to the private process. It also affects whether the given transaction is converted 
from EDI to XML or from XML to EDI. When a transaction is rejected, no conversion 
takes place.

The following table describes the four levels of severity, which can be configured for 
validation errors and their effect on how error information is reported:

Severity 
Level 997 Acknowledgment Error Information to Private 

Process

Data 
Conversion 
Occurs?

Ignore AK5 segment reports transaction 
status of 'A' for accepted. AK3 and 
AK4 segments are not present.

No error report is generated to 
the private process.

Yes

Informational AK5 segment reports transaction 
status of 'A' for accepted. AK3 and 
AK4 segments are not present.

The cause of the error is reported 
in the message to the private 
process with the error code and a 
description of the error. The error 
description begins with Information.

Yes

Warning AK5 segment reports transaction 
status of 'E' for accepted with 
errors. AK3 and AK4 segments 
contain information about the 
location of the error in the 
transaction as appropriate. 

The cause of the error is reported 
in the message to the private 
process with the error code and a 
description of the error. The error 
description begins with Warning.

Yes

Error AK5 segment reports transaction 
status of 'R' for rejected. AK3 and 
AK4 segments contain information 
about the location of the error in 
the transaction as appropriate. 

The cause of the errors is 
reported in the message to the 
private process with the error 
code and a description of the 
error.

No

Fatal Similar in behavior to the 'Error' 
type but is used for system errors.

No

User Type 1 and User Type 2 severity types are not currently supported.
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Severity Scope

The scope of error severity setting is a transaction level. Normally an error severity setting 
applies to all validation errors of the specified type within the entire transaction. 

Validating Severity Levels

The procedure for validating the error severity settings for a transaction is similar to that 
for configuring the guideline for the transaction. You have to first create a Validator 
Profile file for a transaction using EDISIM Validator, and then upload this file in the 
Protocol Editor of the TIBCO BusinessConnect configuration GUI.

Task A Creating a Validator Profile (.apf) File

You can create a Validator Profile file by using the EDISIM Validator.

1. Start EDISIM > Validator.

2. Click Options > Validator Profile.

3. In the Message tab, select a message. Select one of the severity types and save it:

— Ignore

— Informational 

— Warning

— Error

— Fatal

4. In the Save Profile As dialog, save the changed profile to a new profile of the type 
Validator Profile (*.apf).

5. Click File > Open.

An EDI data file is opened, such as sample data X12_5010_850.dat.

6. Click Open.

An EDI compliance check is automatically performed.

Changing the normal error severity of type 1, EDI syntax integrity, validation errors must 
be approached with caution as it can lead to invalid EDI or XML data. The converted EDI 
data can have errors that your trading partner might not accept. The converted XML data 
might not match the XSD used by the private process. Data elements can be shifted 
resulting in invalid data that might not be detected during validation.
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7. Select the guideline to validate the data file: 5010_850 that is imported from 
X12_5010_850.sef (Figure 43). 

Figure 44 shows the validation result.

Figure 43   Select Standard Dialog

Figure 44   EDI Compliance Check

8. Select the standard to use for this guideline, such as X12-4030 (Standards Approved 
for Publication ASC X12 Procedures Review Board through October 1999). 

9. Click OK.

The Diagnostics window provides the Validator analysis of the selected guideline.

Task B Applying the Validator Profile File (.apf) to a Transaction

After creating a Validator Profile file, associate a transaction with the Validator Profile in 
X12 to apply the file to the transaction.
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To apply a Validator Profile file to a transaction:

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Operations Editor.

3. In the right panel, click the X12 link.

4. Expand the operations tree and select the transaction, which you want to configure the 
.apf file for. 

5. Click the Guideline tab.

Figure 45   Edit Notification

6. Next to the Validator Profile File (.apf) field, click change to upload the validator 
profile file.

7. Select the file type:

— File Reference When you select this option, enter the path to the file reference 
you want to use.

— Uploaded File When you select this option, navigate to the location of the file you 
want to upload. In this case, search for the file that you save in Task A.

8. Click OK.

To apply a Validator Profile file to a transaction for a particular operation in a business 
agreement, bind the transaction, and then override the transaction settings. For details, see 
Operation Bindings Tab on page 149.
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Figure 46   Validator Profile File Downloaded

9. Click Save to save the configurations.
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Exporting Interchanges, Groups, and Transactions

This procedure describes how to export interchanges, groups, and transactions.

1. In the left panel, expand BusinessConnect > Operations Editor. 

2. In the right panel, click the X12 link.

3. In the Edit Operations: X12 dialog, click the topmost expand all  to show all 
existing transactions associated with the X12 protocol.

4. Click the radio button next to the interchange, group, or transaction that you want to 
export.

5. Click Export XXX where XXX is Interchange, Group, or Transaction, depending on 
what you select in step 4.

6. Set a password (optional) and click Export Data.

The Save As dialog is displayed with operations.csx as the suggested file name.

7. Click Save to export interchanges, groups, and transactions to the file.
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Importing an Interchange Version

This procedure describes how to import a previously exported interchange version into the 
Operations Editor.

1. In the left panel, expand BusinessConnect > Operations Editor. 

2. In the right corner, select None from the Group by list.

3. Click Import.

4. Next to the Upload Configuration Data File field, click change.

5. Click Browse next to the Upload file field to navigate to a directory containing an 
interchange.

6. Select the .csx file, and then click Open.

7. Click OK.

8. Set a password in needed.

9. Click Import.

Sample Interchange Versions

TIBCO BusinessConnect EDI Protocol powered by Instream provides a sample X12 
interchange version 00403 that can be imported into the TIBCO BusinessConnect 
configuration store. 

The sample interchange version X12-00403.csx is located in the 
BC_HOME\protocols\tibedi\samples\interfaces directory.
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



102 | Chapter 3  Managing X12 Interchanges, Functional Groups, and Transactions
TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



| 103
Chapter 4 Setting Up Trading Hosts

This chapter describes how to set up trading hosts in TIBCO BusinessConnect EDI 
Protocol powered by Instream when using X12.

Topics

• Configuring the X12 Protocol, page 104

• General Tab, page 105

• Preprocessing Tab, page 108

• Logging Tab, page 109

• Advanced Tab, page 110
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Configuring the X12 Protocol

Before you can configure the X12 protocol, the trading host has to be configured. To do 
that, see Setting Up a Host, page 19.

To configure the X12 protocol:

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Participants. 

3. In the right panel, click a host participant link.

4. Click the Protocols tab.

5. If X12 is not displayed in the list of protocols:

a. Click Enable Protocol.

b. Select the X12 check box.

c. Click OK.

6. Click the X12 link.

7. Configure corresponding information in the following tabs:

— General Tab Set host general properties for X12.

See General Tab, page 105.

— Preprocessing Tab Configure how to preprocess inbound and outbound X12 
documents. Preprocessing is necessary if the X12 documents you exchange with 
your trading partner are formatted in any way. For example, preprocessing is 
necessary if the X12 document is blocked at 80 characters per line. 

See Preprocessing Tab, page 108.

— Logging Tab Set up logging properties for inbound and outbound documents. 
These logging properties only apply to X12 documents being exchanged with your 
trading partner. 

See Logging Tab, page 109.

— Advanced Tab Specify that inbound X12 messages, which are converted to XML, 
must be published as a file reference when communicating with private processes. 
You can also use this panel to specify that the converted XML message must be in 
UTF-8 encoding. 

See Advanced Tab, page 110.

8. After you complete the configurations, click Save to save the configurations.
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General Tab 

In the General tab, you can set host general properties for X12.

The following table lists the fields in the General tab: 

Table 17   General Fields (Sheet 1 of 3)

Field Description

Default 
Interchange 
Qualifier ID

The interchange qualifier and ID to use for this trading host. 

• For outbound documents, the qualifier and ID are specified as the interchange 
sender qualifier and ID in the interchange header. 

• For inbound documents, the interchange recipient qualifier and ID are matched 
against the values of this field to ensure that the inbound document is intended for 
this host.

Adding a Default Interchange Qualifier and ID

To add a default interchange qualifier ID:

1. Click the Add New link.

2. Click the Add New button.

3. Select a qualifier from the Interchange Qualifier list. 

This is mapped to the Interchange Qualifier used by the host. For outbound 
documents, the interchange qualifier is not validated for the sender of a document.

4. Enter the mandatory identity for the local host in the ID field. 

This is mapped to the host’s Interchange ID. For example, 987654321 is the fictitious 
DUNS number used in the tutorial. For outbound documents, the interchange ID is 
not validated for the sender of a document.

5. Click Save and then OK.
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AS2 Identifier An identifier to use in the AS2-From header field of the HTTP message. This identifier 
must be mutually agreed upon between trading partners. 

This identifier can be an interchange ID. This only applies when using AS2 Transport.

Add New To use a new AS2 identifier:

1. Click the Add New link.

2. Click the Add New button.

3. Enter a name of the AS2 identity.

4. Select the new AS2 identifier from the list.

Common Code 
Identifier (used 
only for HTTP/S 
transport when 
NAESB/GISB 
packaging is 
selected)

The Common Code Identifier to use in the "from" data element of the outbound 
NAESB packaged HTTP message. It must also be identical to the "to" data element of 
the inbound NAESB packaged HTTP message. This identifier must be mutually 
agreed upon between trading partners who use NAESB packaging. 

DUNS numbers are used for Common Code Identifiers. 

Adding a Common Code Identifier

To add a Common Code identifier:

1. Click the Add New link.

2. Click the Add New button.

3. Enter a DUNS number of the DUNS identity, for example, 987654321.

4. Click Save and then OK.

Valid Email 
Address List

The identifier to use in the From header field of the SMTP MIME message. This email 
address list can be a list of email addresses. 

• For an outbound document sent to the trading partner through SMTP transport, the 
first email address is used in the From header. 

• For incoming email from the mail server, the To email address from the email is 
matched to one of the email addresses in this list. This only applies when using 
AS1 or AS2 transport.

Outbound CAQH CORE2 Username/Password Configurations

Table 17   General Fields (Sheet 2 of 3)

Field Description
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CAQH UserName 
to authenticate at 
Partner

The user name that a CORE-certified host uses to authenticate against a partner’s 
external authentication. For example, the user name might be the email address that a 
partner registers with the host’s authentication system. The values for the username 
and password fields populate the appropriate envelope element of the SOAP message 
sent to a partner. 

This authentication mechanism is used for transactions involving messages that are 
packaged according to the CAQH CORE Phase II Connectivity Rule.

CAQH Password 
to authenticate at 
Partner

The password that a CORE-certified host uses to authenticate against a partner’s 
external authentication. The values for the username and password fields populate the 
appropriate envelope element of the SOAP message sent to a partner. 

This authentication mechanism is used for transactions involving messages that are 
packaged according to the CAQH CORE Phase II Connectivity Rule.

Table 17   General Fields (Sheet 3 of 3)

Field Description
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Preprocessing Tab

In the Preprocessing tab, you can configure preprocessing for inbound and outbound X12 
documents. 

Preprocessing is necessary if the X12 documents that you exchange with your trading 
partner are formatted in any abnormal way. For example, you have to preprocess if the 
X12 document is blocked at 80 characters per line.

The following table lists the fields in the Preprocessing tab: 

Table 18   Preprocessing Fields

Field Description

Inbound and Outbound

Characters To Strip 
(e.g. /r/n; /t; 0D)

The EDI Conversion Engine of TIBCO BusinessConnect EDI Protocol powered by 
Instream requires EDI data that is on a single line. The exception to this requirement 
is when the carriage return is specified as the segment delimiter. 

Specifies any extra formatting characters that might be contained in the EDI 
messages you exchange with your trading partners. These formatting characters are 
not considered part of the EDI data itself. These formatting characters are typically 
used to make the EDI data more readable or to block the EDI data into lines of equal 
length. This can include any carriage return at the end of the data.

For information on the characteristics of EDI data, see TIBCO BusinessConnect EDI 
Protocol powered by Instream User’s Guide.

Strip Chars Between 
Segments 
Boundaries

This check box is selected by default. It provides an easy way to remove formatting 
characters. 

• If you select this check box, it causes any extraneous characters between 
segments to be removed from the EDI file regardless of what is specified in the 
Characters To Strip field. 

• If you clear this check box and no characters are specified in the Characters to 
Strip field, you can get an error in case unwanted characters or any 
unrecognized characters other than the delimiters are found in the document.

Characters To Strip must also be used if the EDI document is blocked into lines of 
equal length because blocked documents contain carriage returns inside of segments. 
Strip Chars Between Segments Boundaries only works between segments. 
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Logging Tab

In the Logging tab, you can configure EDI-specific logging options available with TIBCO 
BusinessConnect EDI Protocol powered by Instream. For further information, see TIBCO 
BusinessConnect EDI Protocol powered by Instream User’s Guide, "Document 
Archiving."

The following table lists the fields in the Logging tab: 

Table 19   Logging Fields

Field Description

Inbound

Log Raw EDI 
Request to File

For inbound, log the original, intact, and unconverted inbound EDI document.

Store Location The original inbound EDI documents are stored in a directory whose name is derived 
from the specified location. 

For information on how the files are named, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "Document Archiving."

Include Date 
Folder 

Select this check box to create a file reference in a created folder based on the current 
date.

Outbound

Log Raw EDI 
Request to File

For outbound, log the raw EDI document sent to the trading partner.

If the option "Publish Information to Insight Reporting" is checked for Outbound, this 
option is used to publish the ediDataFile element.

Log Error Data in 
Separate Directory

Select this check box to log error data in a separate folder.

By default, this check box is cleared.

Store Location The original outbound EDI documents are archived in a directory whose name is 
derived from the specified location. For information on how the files are named, see 
TIBCO BusinessConnect EDI Protocol powered by Instream User’s Guide, "Document 
Archiving."

Include Date 
Folder 

Select this check box to create a file reference in a created folder based on the current 
date.
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Advanced Tab

In the Advanced tab, you can specify advanced settings for the handling of inbound and 
outbound XML documents.

The following table lists the fields in the Advanced tab: 

Table 20   Host Record Advanced Fields (Sheet 1 of 5)

Field Description

Inbound

Publish XML (or 
TEXT) Request as 
File Reference

Write the converted XML or TEXT to a file for each inbound transaction and publish 
the file reference in the requestFile attribute of the ResponderRequest message to the private 
process. 

Use of this option can decrease memory usage, improving performance. The 
Threshold property determines how large the XML or TEXT must be before 
BusinessConnect writes the request to a file; other status values from the user are 
considered a failure.

Threshold (bytes) Specify a file size in bytes. The default value is 0.

TIBCO BusinessConnect writes XML or TEXT requests that are this size and larger 
to a file and sends a reference to that file instead of the request itself. A value of 1000 
is often appropriate. This can decrease memory usage within the EDI processing 
component, improving performance.

Include Date Folder Select this check box to create a file reference in a created folder based on the current 
date. 

This check box is selected by default. 

Store Location Identify the directory in which TIBCO BusinessConnect must store the files. If this 
field is empty or the directory specified is not valid, TIBCO BusinessConnect 
behaves as if Publish XML Request as File Reference is not checked; it does not store a file; it 
sends the XML request.
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Output XML 
Request in UTF-8 
and Remove Empty 
Elements

Select this check box to instruct TIBCO BusinessConnect to perform the following 
tasks: 

• Convert the XML that is in UTF-16 format to UTF-8; 

• Delete XML elements in the request that contain no values. This reduces the file 
size. Reducing the request size is especially important when you are using the 
XML for back-end processing.

Note: Converting the XML from UTF-16 to UTF-8 in this way increases memory 
usage. Consider converting the XML to UTF-8 in a separate JVM process instead of 
using this option.

Use In-memory 
Compression 
During EDI to XML 
(or EDI to TEXT) 
Conversion

Select this check box to instruct TIBCO BusinessConnect to compress information 
stored in memory during the EDI to XML or TEXT conversion process. 

Although compressing and uncompressing data increases the processing time of the 
conversion process, it can greatly reduce memory usage. This option is useful when 
processing interchanges that contain a large number of messages.

By default, this check box is unselected.

Threshold to Use 
File-based Storage 
During EDI to XML 
(or EDI to TEXT) 
Conversion (bytes)

Specify the threshold to use file-based storage during EDI to XML or EDI to TEXT 
conversion.

This threshold has a default value of 20,000,000 bytes (20 MB). 

This threshold is triggered only when an inbound message comes in from a trading 
partner and the threshold is applied on Interchange basis: if the size of the 
interchange is greater than the threshold, the BusinessConnect EDI engine makes the 
conversion engine in-built validate and process all the transactions in that 
interchange, including errors on the disk. Only one currently processed transaction is 
loaded into memory and discarded after processing in chunks, saving memory and 
keeping it low. This also supports the interchange to process a lots of errors without 
loading them into memory. 

Frequent use of this threshold feature for very small sized files slows the 
performance depending on the network and I/O performance. It must be used only 
for fairly large interchanges, or for interchanges with lots of errors. 

Table 20   Host Record Advanced Fields (Sheet 2 of 5)

Field Description
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



112 | Chapter 4  Setting Up Trading Hosts
Inbound and Outbound

Threshold to Use 
File-based Storage 
Prior to EDI 
Processing (bytes)

Specify the threshold to use file-based storage prior to EDI processing.

This threshold has a default value of 1,000,000 bytes (1MB). 

This threshold is triggered for both outbound and inbound messages and applies on 
an interchange basis. If the interchange or XML (in case of outbound) is greater than 
the threshold, it makes sure to be written to a temporary local file and given to the 
conversion engine instead of passing it as a blob to the engine. This reduces the 
memory consumption prior to EDI processing. 

This threshold does not resolve large number of smaller transaction details that are in 
memory, or the number of errors that can still accumulate during processing by the 
conversion engine.

Table 20   Host Record Advanced Fields (Sheet 3 of 5)

Field Description
TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



Advanced Tab | 113
AuditReportLogging

Audit Report 
Location

Specify the location used for audit reporting in EDI to XML processing when 
TIBCO BusinessConnect EDI Protocol powered by Instream validates and converts. 
The Audit Report files are generated by the Instream validation engine in XML form. 

The Audit Report location is also needed to be populated with an appropriate value 
when Insight Reporting Information is published to the private process

The XML files have additional information pointing to the internal details of the 
validated transactions.

Example: C:\temp\DocSplitReport

Include Date Folder Select this check box to create a file reference in a created folder based on the current 
date.

By default, this check box is selected.

• If you select this check box, the date folder is added to the document path. 

• If you clear this check box, the date folder is omitted, and the document is stored 
under the tpName directory.

DocumentSplit

Store Location Specify the directory for storing the document splitting result.

The document splitting results includes the document splitting report, valid 
transaction splitting result, and invalid transaction splitting result.

TIBCO BusinessConnect EDI Protocol powered by Instream generates the following 
folders in the specified directory:

• Invalid: This folder stores the invalid splitting result.

• Valid: This folder stores the valid splitting result.

• Report: This folder stores the splitting report.

Note: If you want to use the document splitting feature, you must specify a value in 
this field.

Table 20   Host Record Advanced Fields (Sheet 4 of 5)

Field Description
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Include Date Folder Select this check box to create a file reference in a created folder based on the current 
date.

By default, this check box is selected.

• If you select this check box, the date folder is added to the document path.

• If you clear this check box, the date folder is omitted, and the document is stored 
under the tpName directory.

CAQH

Store Location Specify the directory for storing the responses or acknowledgement data that is 
waiting to be retrieved from the host.

Include Date Folder Select this check box to create a date sub folder in the CAQH store location based on 
the current date.

By default, this check box is selected.

• If you select this check box, the date folder is added to the CAQH store location.

• If you clear this check box, the date folder is omitted.

Table 20   Host Record Advanced Fields (Sheet 5 of 5)

Field Description
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Setting 

Chapter 5 Setting Up Trading Partners

This chapter describes setting up your trading partners in TIBCO BusinessConnect EDI 
Protocol powered by Instream when using X12. 

Topics

• Configuring the X12 Protocol, page 116

• General Tab, page 117

• Logging Tab, page 123

• Batching Tab, page 124

• Interchange Header Tab, page 126

• Group Header Tab, page 128

• Acknowledgement Tab, page 130

• CAQH Tab, page 133

• Document Split Tab, page 135

• Control Numbers Tab, page 137

• Delimiters Tab, page 140

• Transports Tab, page 141
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Configuring the X12 Protocol

Before you can configure the X12 protocol, the trading partner has to be configured. To do 
that, see Setting Up a Partner, page 21.

To configure the X12 protocol:

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Participants. 

3. In the right panel, click a partner participant link.

4. Click the Protocols tab.

5. If X12 is not displayed in the list of protocols:

a. Click Enable Protocol.

b. Select the X12 check box.

c. Click OK.

6. Click the X12 link. 

7. Configure corresponding information in the following tabs:

— General Tab, page 117

— Logging Tab, page 123

— Batching Tab, page 124

— Interchange Header Tab, page 126

— Group Header Tab, page 128

— Acknowledgement Tab, page 130

— CAQH Tab, page 133

— Document Split Tab, page 135

— Control Numbers Tab, page 137

— Delimiters Tab, page 140

— Transports Tab, page 141

8. After you complete the configurations, click Save to save the configurations.

T To properly mark the ISA, GS, and ST segments with a DSR mark, as required for proper 
acknowledgments generation, see the documentation provided with the EDISIM 
Standards Editor.
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General Tab

In the General tab, you can set general trading partner properties for X12.

The main general trading partner properties for X12 include:

• Interchange qualifier and ID

• Enable EDI validation for inbound or outbound transactions

• Enable duplicate detection

• Disable EDI to XML (or EDI to TEXT) conversion of inbound transactions

The following table lists the fields in the General tab:

Table 21   General Fields (Sheet 1 of 6)

Field Description

Default Interchange 
Qualifier ID

Specify the interchange qualifier and ID to use for this trading partner. 

• For outbound documents, the qualifier and ID are specified as the interchange 
receiver qualifier and ID in the interchange header. 

• For inbound documents, the interchange sender qualifier and ID are used to 
identify the sender.

To add a default interchange qualifier ID:

1. Click the Add New link.

2. Click the Add New button.

3. Select a qualifier from the Interchange Qualifier list. 

4. Enter the mandatory domain name. 

This is mapped to the Interchange Qualifier used by the trading partner. 

5. Enter the mandatory identity for the partner in the ID field. 

This is mapped to the partner’s Interchange ID. For example, 987654321 is the 
fictitious D-U-N-S number used in the tutorial. 

6. Click Save and OK.

7. Select the new Interchange Qualifier ID from the list.
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AS2 Identifier Specify an identifier to use in the AS2-To header field of the HTTP message. This 
identifier must be mutually agreed upon between trading partners. 

This identifier can be an interchange ID. This only applies when using AS2 
Transport.

Add New To use a new AS2 identifier:

1. Click the Add New link.

2. Click the Add New button.

3. Enter a name of the AS2 identity.

4. Select the new AS2 identifier from the list.

Common Code 
Identifier (used only 
for HTTP/S 
transport when 
NAESB/GISB 
packaging is selected 
)

Specify the common code identifier to use in the "to" data element of the outbound 
NAESB packaged HTTP message. 

It must also be identical to the "from" data element of the inbound NAESB 
packaged HTTP message from this partner. This identifier must be mutually agreed 
upon between trading partners who use NAESB packaging. DUNS numbers are 
used for common code identifiers. 

To add a common code identifier:

1. Click the Add New link.

2. Click the Add New button.

3. Enter a DUNS number of the DUNS identity.

4. Click Save and then OK.

Valid Email Address 
List

Specify the email address to match against incoming email from the mail server. If 
the incoming email From address matches to any email address in this list, this 
trading partner is recognized as the sender. 

This only applies when using AS1 or AS2 transport.

Inbound

Enable EDI 
Validation

Select this check box to validate inbound EDI documents before TIBCO 
BusinessConnect converts and forwards them to the private process. This involves 
using the guidelines configured in the configuration store to validate inbound EDI 
data. For Publish Information to Insight Reporting to take effect, you must select 
the Enable EDI Validation check box.

By default, this check box is selected.

Table 21   General Fields (Sheet 2 of 6)

Field Description
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Disable EDI to XML 
(or EDI to TEXT) 
Conversion

Select this check box to disable EDI to XML or EDI to TEXT conversion of 
inbound documents. 

The validation of inbound X12 documents occur using the guidelines configured in 
the configuration store. However, the XML or TEXT file corresponding to the 
inbound X12 data is not generated. The ResponderRequest message is still sent to the 
private process. However, the request attribute of the ResponderRequest message is not 
populated.

This option must be used when XML or TEXT conversion of the EDI data is not 
required. Using this option reduces memory utilization and improves performance.

By default, this check box is cleared.

Enable Transaction 
Duplicate Detection

Select this check box to enable detection for duplicate inbound transactions.

By default, this check box is cleared.

When you select this check box, all inbound transactions that are received from the 
trading partner are checked to see whether a duplicate is received and appropriately 
marked in the RESPONDER.REQUEST PP message. The duplicate attribute in 
ResponderRequest is marked as true if the same message is received from the trading 
partner.

X12 has the following attributes: Trading Partner Name, operationID, transactionName, 
whole transaction (only the ST to SE segments for X12), host initiates flag, 
interchange control number, group control number, and transaction control number.

Extra Info in Private 
Process Request 

Specify the data included in the message to the private process for each message 
received from this trading partner. For example, you can use this field to pass 
routing information based upon the trading partner. 

Allowable Receiver 
Identifier List (e.g. 
ZZ:50291; ZZ:50292

Specify a list of interchange qualifiers and identifiers supported for this trading 
partner. 

Normally, only interchanges with the qualifier and identifier specified in the 
Default Interchange Qualifier - ID field are supported for a trading partner. When 
a trading partner uses multiple interchange qualifiers and IDs, the additional 
qualifiers and IDs to be supported can be specified in this field.

To specify the allowable list of identities, follow the following syntax:

Qualifier:ID[;Qualifier:ID]

Table 21   General Fields (Sheet 3 of 6)
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 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



120 | Chapter 5  Setting Up Trading Partners
Partner Level 
Security Option 
(MIME Encode 
Messages Only)

Select one item from the list to specify what kind of messages that you expect from 
this partner for this particular transaction set.

In the list, the following options are available: 

• None

• Plain Text Only 

• Signed Only

• Encrypted Only

• Signed And Encrypted

For example, if you expect only signed messages for this particular transaction set 
from a partner, but the partner, or someone posing as the partner, sends this 
particular transaction set in a plain text message, TIBCO BusinessConnect rejects 
the message.

If a message is rejected, it is logged as an ERROR transaction, and an error advisory is 
published. The rejected message is not published to the Responder private process.

Enable Interchange 
Complete Message

Select this check box to enable sending a private process message on RVCM subject 
or queue AX.BC.installation.X12.RESPONDER.INTERCHANGE.COMPLETE.

Enable Audit Report 
Logging

Select this check box to enable audit report logging for the complete inbound 
interchanges. 

This audit report file reference is sent to the private process with the Enable 
Interchange Complete Message field.

Publish Information 
to Insight Reporting

If enabled, this option publishes a report on the "Messages received from the trading 
partner" both synchronous and asynchronous. 

Table 21   General Fields (Sheet 4 of 6)
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Inbound EDI Data 
Encoding

Specify the type of encoding for inbound EDI data.

• If inbound EDI data contains the BOM header, such as UTF-8 and UTF-16 
encoding, TIBCO BusinessConnect EDI Protocol powered by Instream gets the 
encoding from the BOM header regardless of what value you set in this field.

• If inbound EDI data does not contain the BOM header, such as ISO-8859-1 and 
US-ASCII encoding, TIBCO BusinessConnect EDI Protocol powered by 
Instream checks whether the value in this field is set.

— If you set a value in this field, TIBCO BusinessConnect EDI Protocol 
powered by Instream uses the specified encoding type to process inbound 
EDI data.

— If no value is set in this field, TIBCO BusinessConnect EDI Protocol 
powered by Instream uses the system encoding of the TIBCO 
BusinessConnect Interior Server engine to process inbound EDI data.

Outbound

Enable EDI 
Validation

Select this check box to validate outbound EDI documents before TIBCO 
BusinessConnect converts and forwards them to the trading partner. This involves 
using the guidelines configured in the configuration store to validate outbound EDI 
data. 

By default, this check box is cleared.

When you select this check box:

• For the XML payload sent from private processes, both transaction values are 
validated as well as the envelope information. 

• For EDI payload sent from private processes, the whole EDI document with 
envelope is validated.

• For Publish Information to Insight Reporting to take effect, you must select 
this check box.

Table 21   General Fields (Sheet 5 of 6)
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 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



122 | Chapter 5  Setting Up Trading Partners
Transaction Level 
Duplicate Detection

Select one item from the list to specify how duplicate documents from private 
processes are handled. All attributes contribute to detect whether a message is as 
duplicate or not.

• None No outbound duplicate detection is performed.

• Allow to TP If a duplicate document is sent, the message is marked as duplicate 
and returned to the private process through an attribute in the InitiatorResponse 
message. The message is sent to the trading partner.

• Deny to TP If a duplicate document is sent, the message is marked as duplicate 
and returned to the private process through an attribute in the InitiatorResponse 
message. The message is not sent to the trading partner.

Publish Information 
to Insight Reporting

Select this check box to publish a report on the "Messages sent to the trading 
partner" synchronous response and regular non-batch messages. 

Outbound XML to 
EDI Data Encoding *

Specify the type of encoding for outbound XML to EDI data.

This field is required.

The default value is US-ASCII.

Add BOM for UTF 
Encoding *

Select this check box to add the BOM for UTF encoding.

By default, this check box is selected.

Replace Element 
Value (e.g. 
E-7088=,:,|E-6032=.:,
)

Specify a list of translation specifications. 

Each specification causes the translation of an XML element value from one value 
to another. This replacement is done before the XML is converted to EDI. 

The replacement syntax is from_value:to_value. 

For example, if the XML has an element named E-100_3_02, which is of type 
numeric, and you want to convert the decimal point from a period (.) to a comma (,), 
enter the value: E-100_3_02=.:,

Add Click Add to add a translation specification to the list.

After adding translation specifications to this list, you can also remove the 
unwanted ones by selecting them and clicking Remove.

Table 21   General Fields (Sheet 6 of 6)
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Logging Tab

In the Logging tab, you can configure EDI-specific logging options available with TIBCO 
BusinessConnect EDI Protocol powered by Instream. 

For further information, see TIBCO BusinessConnect EDI Protocol powered by Instream 
User’s Guide, "Document Archiving."

The following table lists the fields in the Logging tab: 

Table 22   Logging Fields

Field Description

Inbound
Interchange Level

Log Raw EDI 
Segments to File

Store each individual interchange in an inbound X12 document into a separate file. 

For Publish Information to Insight Reporting to take effect, you must enable this 
option.

Store Location The original inbound EDI documents are stored in a directory whose name is derived 
from the specified location.

For information on how the files are named, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "Document Archiving."

Transaction Level

Log Raw EDI 
Segments to File

Store each individual transaction in an inbound X12 document into a separate file. 

A transaction consists of all segments between the ST and SE segments, inclusive. You 
can check this option at the transaction level. 

Note: By specifying this setting, together with the value in the Store Location field 
and Include Envelope Segments, you can enable the EDI_TXN_FROM_TP Resend option 
in the Log Viewer.

Include Envelope 
Segments

For transaction-level logging, include the interchange and functional group header and 
trailer segments along with the X12 transaction.

Store Location The original inbound EDI documents are stored in a directory whose name is derived 
from the specified location.

For information on how the files are named, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "Document Archiving."
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Batching Tab

In the Batching tab, you can set the transporting gateway.

The following table lists the fields in the Batching tab: 

Trading partner and Gateway level batching is not supported for NAESB.

Table 23   Batching Fields

Field Description

Outbound

Allow Single 
Transmission for 
Multiple 
Exclusively-batched 
Interchanges

Select this check box to support single transmission for multiple 
exclusively-batched interchanges.

By default, this check box is cleared.

In the Operations Editor, if you select Exclusively from the Batch Option list for 
a transaction action, the interchange containing this transaction can only contain 
this type of transaction. However, you can still put multiple interchanges, each 
containing a different type of transaction, into a single batch and send it to the 
trading partner.

This feature and Increment Interchange Control Number by Operation ID for 
Exclusive Batch are mutually exclusive.

Increment 
Interchange Control 
Number by Operation 
ID for Exclusive 
Batch 

Select the check box to increment interchange control numbers based on 
transaction types in addition to partner ID qualifiers. 

By default, this check box is cleared. 

With this feature, you can configure how to increment interchange control 
numbers based on a particular trading partner, and on the transaction type, such as 
850 for a particular interchange or group version. It only applies to the case of the 
Exclusive batch where an interchange can only contain one type of transaction, 
and also where multiple interchanges in a single transaction are not supported. 

This feature and Allow Single Transmission for Multiple Exclusively-batched 
Interchanges are mutually exclusive.
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Regenerate Control 
Number For Batch 
Resend

Select this check box to regenerate control number for batch resend. 

• If you select this check box, a control number is regenerated for all 
transactions in this batch when resent.

• If you clear this check box, the already created control number is used for all 
transactions in this batch when resent.

By default, this check box is selected.

For information about how to override this setting, see TIBCO BusinessConnect 
EDI Protocol powered by Instream, Gateway Configuration, "Regenerate 
Control Number For Batch Resend."

Publish Information 
to Insight Reporting 
for Batch

Select this check box to publish a report on the Messages that are batched and sent 
to the trading partner.

By default, this check box is cleared.

Destination File Mask 
for Batch

Specify the file mask which is used to generate the file name for batch 
transactions.

Use Transporting Gateway

Gateway (override 
scheduler and 
transport settings)

Specify a Gateway partner name to specify the Gateway transport for this trading 
partner. 

By using the same Gateway transport for multiple X12 trading partners, you can 
send outbound X12 documents to just one URL and to set scheduling for multiple 
X12 trading partners in one place. With the batching functionality of the Gateway 
transport, transactions of multiple trading partners can be batched in a single 
document and send to the Gateway. In either scenario, the Gateway represents the 
commercial VANs where transactions are distributed to the target trading partners.

Note: If the Gateway override feature is used, NAESB is not supported and only 
X12 protocol can be used.

For more information about using Gateway, see TIBCO BusinessConnect EDI 
Protocol powered by Instream, Gateway Configuration.

Table 23   Batching Fields (Cont’d)

Field Description
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



126 | Chapter 5  Setting Up Trading Partners
Interchange Header Tab

In the Interchange Header tab, you can specify the settings to use in composing the 
interchange header (ISA segment) for documents sent to this trading partner.

The following table lists the fields in the Interchange Header tab: 

Table 24   Interchange Header Fields

Field Description

Outbound
Authorization Information

ISA01 Qualifier* Required. Code identifying the type of information specified in the ISA02 
Information field. 

The default value is 00, indicating that no authorization information is present. 

ISA02 Information Information used for additional identification or authorization of the interchange 
sender or the data in the interchange.

Security Information

ISA03 Qualifier* Required. Code identifying the type of information specified in the ISA04 
Information field. 

The default value is 00, indicating that no security information is present.

ISA04 Information Security information about the interchange sender or the data in the interchange.

Date and Time Formats

ISA09 Date Format* Required. The date when any outbound interchanges are prepared.

The macro YYMMDD can be specified to have the current system date inserted in the 
designated format into this field when an interchange is being prepared.

ISA10 Time Format* Required. The time when any outbound interchanges are processed.

The macro HHMM can be specified to have the current system time inserted in the 
designated format into this field when an interchange is being prepared.

Others

ISA11 Control 
Standard (4012 And 
Lower)

The agency responsible for the interchange control standard used by the 
transaction that is enclosed by the interchange header and trailer. 

The default value is U. 
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ISA11 Repeating 
Separator (4020 and 
Higher)

Character used to separate repeated occurrences of a simple data element or a 
composite data structure. This character must differ from the data element 
separator, component element separator, and the segment terminator. 

The default value is *.

Earlier versions of X12 do not specify a repeating separator. In these earlier 
versions, an interchange control standard identifier is specified in the interchange 
segment instead.

ISA14 Ack 
Requested*

Required. Code sent by the sender to request an interchange acknowledgment. 

The default value is 0, indicating that no interchange acknowledgment is requested.

ISA15 Usage 
Indicator*

Required. Code indicating whether data enclosed by this interchange envelope is 
test, production or information. 

The default value is P, indicating Production. 

ISA16 Component 
Element Separator*

Character used to separate component data elements within a composite data 
structure. This character must differ from the data element separator, segment 
terminator, and repeating separator.

The default value is +.

Table 24   Interchange Header Fields (Cont’d)

Field Description
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Group Header Tab

In the Group Header tab, you can specify the settings to use in composing the functional 
group header (GS segment) for transactions sent to this partner.

The following table lists the fields in the Group Header tab: 

Table 25   Group Header Fields

Field Description

Outbound
Application Code

GS02 Sender The application sender's code in the GS segment of an X12 document that identifies the 
party sending the X12 group. Codes are agreed upon between trading partners. 

GS03 Receiver The application receiver’s code in the GS segment of an X12 document. This code 
identifies the party sending the X12 group. Codes are agreed upon between trading 
partners. 

Date and Time Formats

GS04 Date 
Format*

Required. The date when any outbound groups are prepared.

• The macro CCYYMMDD can be specified to have the current system date inserted in the 
designated format into the GS04 field when a group is being prepared.

• The macro YYMMDD is used for earlier X12 versions where the GS04 field is 
designated as a 6-character field.

GS05 Time 
Format*

Required. This is the time when any outbound groups are prepared and must be specified 
in 24-hour clock format. 

• The macro HHMM can be specified to have the current system time inserted in the 
designated format into the GS05 field when a group is being prepared. 

• The macro HHMMSSD can also be specified to have the current system time inserted in 
the designated format into the GS05 field. SS indicates the current seconds, and must be 
a value between 00 and 59. D indicates one tenth of a second, and must be a value 
between 0 and 9. For example, if the current time is 16:50:23 618 and the HHMMSSD 
format is set in GS05, the value in the converted X12 data is 1650236.
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When an XML document is sent over the X12 protocol from the private process, if the 
values GS02/GS03 are not overridden by the private process InitiatorRequest message, 
these values from the GS02/GS03 fields under Trading Partner > X12 Protocol > 
Group Header are used during the XML-to-EDI conversion. If no values are specified in 
these GS02/GS03 fields, the values GS02/GS03 (Application Code Sender/Receiver) 
from Operations Editor > X12 > Group Version are used instead in the final EDI output.
 TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



130 | Chapter 5  Setting Up Trading Partners
Acknowledgement Tab

In the Acknowledgement tab, you can specify the settings to use in composing the 
acknowledgments for documents sent by this trading partner.

For more information on acknowledgments, see Acknowledgments on page 7, and TIBCO 
BusinessConnect EDI Protocol powered by Instream User’s Guide, Chapter 5, 
"Acknowledgments and Reconciliation."

If you want to generate acknowledgments for inbound X12 transactions, the guideline of 
inbound transactions must contain the DSR mark for ISA, GS, and ST segments.

• The DSR mark for ISA segments must be ISA1.

• The DSR mark for GS segments must be GSSG.

• The DSR mark for ST segments must be STST.

The following table lists the fields in the Acknowledgement tab: 

Table 26   Acknowledgement Fields (Sheet 1 of 3)

Field Description

Inbound

Ack Creation 
Option

Select one item to define what acknowledgments are created for this partner by the host. 
The possible acknowledgment creation options by TIBCO BusinessConnect EDI 
Protocol powered by Instream are:

• None No acknowledgment is created.

• Interchange, Group and Txn  Creates a TA1 and a 997 or 999 acknowledgment. 

• Interchange and Group Creates a TA1 and a 997 or 999 acknowledgment. The 997 
acknowledgment is verified only for the group response. For this setting, HIPAA 
Acknowledgments must not be generated.

• Interchange Only Creates a TA1 acknowledgment. For this setting, HIPAA 
Acknowledgments must not be generated.

• Group and Txn Creates a 997 or 999 acknowledgment.

• Group Only Creates a 997 or 999 acknowledgment with group response. For this 
setting, HIPAA Acknowledgments must not be generated.
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999 Ack 
Creation Option 
*

Specify the 999 Ack Creation option.

By default, this check box is cleared.

If you select this check box, the 999 Ack Creation option is based on the options 
described in the Ack Creation Option list.

Ack Creation 
Based on ISA14 
Ack Requested

Select this check box to control whether the acknowledgment creation is determined 
based on the value of field ISA14 in the interchange envelope segment of the incoming 
document. 

• When you select this check box and set field ISA14 to 1, acknowledgment 
generation is based on Ack Creation Option.

• When you select this check box and set field ISA14 to 0, acknowledgments are 
generated regardless of Ack Creation Option.

By default, this check box is cleared.

Ack Version 
Option

Select one item from the list to specify the acknowledgment version option.

• Transaction group version in GS08 (default) This option carries the original 
inbound EDI document group version of the transaction that is acknowledged. For 
example, if the group version is 004030, the GS08 of the 997 is also 004030. 

• Transaction group version in AK103 If the transaction being acknowledged has 
the group version of 4061 and higher for 999s, or group version 4041 and higher for 
997s, the appropriate acknowledgment carries the inbound EDI transaction groups 
version in the AK103 element. This AK103 value is used to reconcile the original 
transaction for the group version of the transaction. 

• Always generate same ack version HIPAA, X12N and VICS group versions are 
not allowed for this usage. With this option, the original base part of the groups is 
generated, and its value must be specified in the Ack Version field. 

Ack Version Specify the acknowledgment version.

The value entered is not used for HIPAA, X12N and VICS transactions. To be created, 
the value has to be 4041 or higher for 997, and 4061 or higher for 999s; for example, a 
value of 005010 can be specified.

Ack File Mask Specify the file name by using file masks for generated acknowledgment data.

The default value is #(TpName)-#(DocID)-#(YYYYMMDDHHMISSNNN).ack.response.

Do not use special characters in the file name.

Table 26   Acknowledgement Fields (Sheet 2 of 3)
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Outbound

Ack Expected 
Option

Select one item from the list to define which acknowledgments that a host expects from 
this trading partner. 

The possible acknowledgment acceptance options are:

• None No acknowledgment is expected and the transaction is completed after sent to 
the participant.

• Interchange, Group and Txn The host expects a TA1/997 or 999 acknowledgment 
from this partner to have this outbound transaction reconciled and accepted.

• Interchange and Group The host expects a TA1/997 or 999 acknowledgment from 
this partner to have this outbound transaction reconciled and accepted. The 997 or 
999 acknowledgment is verified only for the group response.

• Interchange Only The host expects a TA1 acknowledgment to have this transaction 
reconciled and accepted. The TA1 acknowledgment is verified only for the 
interchange response. 

• Group and Txn The host expects a 997 or 999 acknowledgment from the partner.

• Group only The host expects a 997 or 999 acknowledgment from its partner with a 
Functional Group response to have this outbound transaction reconciled and 
accepted.

999 Ack 
Expected 
Option*

Specify the expected 999 acknowledgment option.

By default, this check box is cleared.

If you select this check box, the 999 Ack is expected for outbound transactions with 
group versions 004061 and higher, based on the options described in the Ack Expected 
Option list.

999 Ack Only * is for Group Version 004061 and higher

Table 26   Acknowledgement Fields (Sheet 3 of 3)

Field Description
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CAQH Tab

In the CAQH tab, you can specify settings for the CAQH function.

The following table lists the fields in the CAQH tab: 

Table 27   CAQH Fields  (Sheet 1 of 2)

Field Description

Inbound

CAQH SenderID / 
ReceiverID Checking

Select an item from the list to specify if the EDI protocol should check for Sender 
and Receiver ID values in the Interchange ID list when the Responder receives a 
CAQH message.

• ISA06/ISA08 Specifies that the EDI protocol should verify Sender and 
Receiver ID values in the Interchange ID list.

• Off Specifies that the EDI protocol need not verify the SenderID and Receiver 
ID values in the Interchange ID list.

The default value is ISA06/ISA08.

Ack Creation for 
CAQH Batch 
Submission Message

Select this check box for the EDI protocol to create acknowledgments for inbound 
batch submission message based on the configuration in the Acknowledgement and 
HIPAA Acknowledgement tabs.

By default, this check box is selected.

Ack Creation for 
CAQH Batch Results 
Retrieval Message

Select this check box for the EDI protocol to create an acknowledgment for the 
retrieved batch response message based on the configuration in the 
Acknowledgement and HIPAA Acknowledgement tabs.

By default, this check box is selected.

Correlating Batch 
Transactions Base on 
CAQH PayloadID

Select this check box to specify if the EDI protocol should only retrieve 
Response/Acknowledgment prepared for the original inbound batch submission 
request which contain the same PayloadID as the retrieval request.

By default, this check box is selected.

Outbound
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CAQH SenderID / 
ReceiverID Setting

Select an item from the list to specify how the EDI protocol should generate the 
Sender and Receiver IDs for a CAQH message when the Private Processor does not 
specify the Sender and Receiver IDs.

• ISA06/ISA08 X12 protocol uses ISA06/ISA08 values of EDI data as 
SenderID/ReceiverID of the CAQH message.

• GS02/GS03 X12 protocol uses GS02/GS03 values of EDI data as 
SenderID/ReceiverID of the CAQH message.

The default value is ISA06/ISA08.

Batch 
Response/Acknowled
gement Maximum 
Wait (minutes)

Specify how long the Responder will keep the acknowledgment / response data.

The default value is 1440 minutes or 1 day.

This value cannot be less than 1 or a decimal.

Delete Batch 
Response/Acknowled
gement Data After 
Timeout

Select this check box to delete response / acknowledgment saved in the CAQH store 
location after the timeout.

If you clear this check box, EDI protocol will not delete the expired 
response/acknowledgment from CAQH store location, but add the suffix .expire for 
the expired EDI files.

By default, this check box is selected.

Table 27   CAQH Fields  (Sheet 2 of 2)

Field Description
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Document Split Tab

In the Document Split tab, you can specify settings for the document splitting function. 

If you want to save the document splitting results, you must specify the location for 
storing the results in the Advanced Tab configured for the trading host.

With the document splitting feature, TIBCO BusinessConnect EDI Protocol powered by 
Instream can split an invalid transaction into a valid part and an invalid part, and then 
convert valid part data to XML data. 

TIBCO BusinessConnect EDI Protocol powered by Instream performs the document 
splitting of X12 files based on the settings in the TIBEDI_HOME/config/X12_DocSplitter.ini file. 
For details on how to set splitting points, see the TIBCO Foresight Instream Document 
Splitter documentation.

The following table lists the fields in the Document Split tab: 

If you want to use the document splitting feature, note the following items:

• You must install TIBCO Foresight Instream® Standard Edition 8.5.0 or later.

• TIBCO BusinessConnect EDI Protocol powered by Instream only splits invalid 
transactions.

Table 28   Document Split

Field Description

Inbound

Enable Document 
Split

Select this check box to enable the document splitting feature for X12 transactions 
with validation errors.

By default, this check box is cleared.
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Split Report 
Contents

Specify whether to generate document splitting reports and what kinds of document 
splitting reports to be generated.

• If you select Disable from this list, TIBCO BusinessConnect EDI Protocol 
powered by Instream does not generate document splitting reports.

• If you select Valid from this list, TIBCO BusinessConnect EDI Protocol 
powered by Instream generates document splitting reports, and the splitting 
reports only include the contents of the valid part.

• If you select Invalid from this list, TIBCO BusinessConnect EDI Protocol 
powered by Instream generates document splitting reports, and the splitting 
reports only include the contents of the invalid part.

• If you select Both from this list, TIBCO BusinessConnect EDI Protocol 
powered by Instream generates document splitting reports, and the splitting 
reports only include the contents of both the valid and invalid parts.

Convert Valid Data 
to XML (Only for 
Single Valid Data)

Select this check box to enable the product to convert the valid part of the splitting 
result to XML data after the document splitting process.

By default, this check box is cleared.

Table 28   Document Split (Cont’d)

Field Description
TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



Control Numbers Tab | 137
Control Numbers Tab

In the Control Numbers tab, you can specify settings, which affect the validation or 
generation of control numbers for this trading partner. 

The inbound settings affect the validation of control numbers in documents received from 
this trading partner. The outbound settings affect the generation of control numbers to be 
included in documents sent to this trading partner.

For more information on control numbers, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "Control Number Management."

The following table lists the fields in the Control Numbers tab: 

Table 29   Control Numbers Fields (Sheet 1 of 3)

Field Description

Inbound

Group Control 
Number Increment 
Across Interchanges

Select True or False to specify whether to validate that group control numbers 
increment across interchanges.

Interchange Control 
Number Sequence 
Check

Specify how interchange control numbers are validated across a sequence of 
transactions.

• None No validation is performed.

• Incremental Successive interchange control numbers must increase by 1.

• Chronological Successive interchange control numbers must increase by >= 1.

Group Control 
Number Sequence 
Check

Specify how group control numbers are validated across a sequence of interchanges 
or transmissions. 

• None No validation is performed.

• Incremental Successive group control numbers must increase by 1.

• Chronological Successive group control numbers must increase by >= 1.

If you select Incremental, you must avoid some possible problems. For more 
information, see TIBCO BusinessConnect EDI Protocol powered by Instream User’s 
Guide, "Senders and Receivers Falling out of Sync with Incremental Control 
Numbers."
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Transaction Control 
Number Sequence 
Check

Specify how transaction control numbers are validated within a group or an 
interchange. 

• None No validation is performed.

• Incremental Successive transaction control numbers must increase by 1.

• Chronological Successive transaction control numbers must increase by >= 1.

Reset on Save Select this check box to force the recycling of control numbers on demand. This 
applies to control numbers for inbound. On inbound documents, the resetting of the 
control numbers can reset the inbound trading partner control numbers, which are 
used in control number validation. As a result, the validation starts again based on 
the next incoming document from the trading partner.

By default, this check box is cleared.

Reset Across ALL 
domains.

Select this check box to reset the control numbers across all domains.

By default, the check box is cleared.

Outbound

Increment Group 
Control Number 
across Interchanges

Select True or False to specify whether to increment group control numbers across 
interchanges.

The default value is True.

Increment 
Transaction Control 
Number 
Sequentially across 
Interchanges

Select True or False to specify whether to increment transaction control numbers 
sequentially.

The default value is False.

Interchange Control 
Number Seed

Specify the interchange control number starting point.

The default value is 0.

Interchange Control 
Number End

Specify the interchange control number ending point. The next interchange after the 
ending point is numbered with the seed.

The default value is 999999999.

Group Control 
Number Seed

Specify the group control number starting point.

The default value is 0.

Table 29   Control Numbers Fields (Sheet 2 of 3)

Field Description
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Transaction Control 
Number Seed

Specify the transaction control number starting point.

The default is 0.

Reset on Save Select this check box to force the recycling of control numbers on demand. This 
applies to control numbers for inbound. 

By default, this check box is cleared.

If you select this check box, on outbound documents, the resetting of the control 
numbers force the outbound control numbers for a trading partner to start from the 
seeding value again before reaching the ending value. As a result, the control 
number of the next outbound document is generated based on the seeding value.

Reset Across ALL 
domains.

Select this check box to reset the control numbers across all domains.

By default, the check box is cleared.

Table 29   Control Numbers Fields (Sheet 3 of 3)

Field Description
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Delimiters Tab

In the Delimiters tab, you can specify the delimiters to be used when composing X12 
documents to be sent to this trading partner.

Only one character per delimiter can be used for the X12 Protocol.

For information on X12 delimiters, see Delimiters, page 6.

The following table lists the fields in the Delimiters tab: 

Each delimiter value must be unique. For example, the Segment Delimiter value cannot be 
set for the Element Separator, or for other delimiters.

Table 30   Delimiters Fields

Field Character Description

Outbound

Segment 
Terminator *

’
(apostrophe)

The character indicating the end of a segment.

A segment terminator must be a single character.

Data Element 
Separator *

~
(tilde)

The character used to separate data elements in a segment.

A data element separator must be a single character.

Replacement 
Char *

|

(vertical bar)

The character used to replace values in XML data that are the same 
as delimiters defined in configuration. A replacement character 
cannot be identical to any other delimiters. 

The required value format is a single character or a hexadecimal 
number.

Extra Segment 
Terminators (e.g. 
0x0d,0x0a)

The additional characters of the segment terminator when the 
segment terminator consists of more than one character. The first 
character of the segment terminator is always specified in the 
Segment Terminator field. The additional segment terminator 
characters are specified in this field.

Extra Segment Terminators cannot have the same values as the 
ones used for Data Element Separator or Segment Terminator.
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Transports Tab

In the Transports tab, you can configure outbound transport settings for this trading 
partner. To add an outbound transport, click Add in the Transports tab. 

The following transports are available for use with this protocol:

• HTTP/S

If you select the GISB/NAESB Package check box, the outbound message is 
packaged in the NAESB Internet ET format. For more details about the NAESB 
Internet ET package standard, see NAESB, page 142 and Configuring HTTP/S for 
NAESB Internet ET, page 142.

• FTP/S

• FILE

• AS2-HTTP/S

• AS1-EMAIL

• EMAIL

• SSHFTP

• Inbox

This option is available to support document exchange between partners running 
TIBCO BusinessConnect EDI Protocol powered by Instream and one of the following 
products: 

— TIBCO BusinessConnect™ Plug-in for SSH Server

— TIBCO BusinessConnect™ Plug-in for FTP Server

— TIBCO PartnerExpress™

To send or receive CAQH messages with HTTP MIME Multipart envelope, add the below 
query string in the outbound transport URL:

The query string takes the form:

package = x12-caqh-mime

For example:
server1.company.example.com:6700/X12?package=x12- caqh-mime

NAESB packaging is supported only for the HTTP and HTTPS transports. It is currently 
not supported for the HTTPSCA transport.
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For more information, see TIBCO BusinessConnect EDI Protocol powered by 
Instream User’s Guide, "Set Up Trading Partner Transport via Inbox."

The steps required for configuring transports are essentially the same for all protocols. For 
details, see the transports chapters in TIBCO BusinessConnect Trading Partner 
Administration Guide. For EDI-specific transport configuration, see TIBCO 
BusinessConnect EDI Protocol powered by Instream User’s Guide, Chapter 6, File Masks.

The transports you configure serve as the default transports for all business agreements 
associated with this partner. You can override the default transport settings as part of the 
business agreement.

NAESB 

NAESB Internet ET stands for North American Energy Standards Board Internet 
Electronic Transport. Its earlier version, GISB EDM - GISB (Gas Industry Standards 
Board) electronic Delivery Mechanism standard was an EDI transport mechanism to 
support reliable and secure transactions over the Internet. 

NAESB Internet ET is designed to transfer all data types: text, EDI, or XML; it is used by 
the energy industry to transmit X12 EDI messages. It has the following characteristics:

• It can use a regular internet transport such as HTTP/S or even a Web browser on the 
client side.

• It supports any payload, such as EDI, flat files, or XML.

• It standardizes only how packages are exchanged, regardless of the business process.

• For security, it supports HTTP/S, HTTP Basic Authentication, PGP encryption, and 
signature to payloads.

• It standardizes error codes and how errors are returned back to the sender: 
synchronously or asynchronously.

Configuring HTTP/S for NAESB Internet ET

To configure the HTTP and HTTPS transports for NAESB Internet ET protocol, use the 
descriptions provided in Table 31. 

Table 31   Configuring NAESB Internet ET (Sheet 1 of 4)

Field Description

Transport Name Specify an identifier for these transport settings.
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URL Specify the URL for the trading partner. 

For NAESB, this primary URL is also used to send an Error Notification. The URL for 
NAESB must contain the query string package=naesb. For example: 
server1.company.example.com:6900/X12?package=naesb

Server Certificate

(HTTPS only) 

Specify the participant’s certificate used to encrypt communication.

Note: You must configure the credentials in advance, before creating this transport. For 
more details about server certificates, see TIBCO BusinessConnect Trading Partner 
Administration, "New Certificate."

Use HTTP Basic 
Authentication

Select this check box to enable basic authentication at the trading partner. 

The user name and password set in those fields are provided when accessing the trading 
partner. The trading partner serves requests only if it can validate the supplied user 
name and password. Note that the password is passed in plain text across the network.

Username Specify a user name for the trading partner that you receive from the trading partner.

Password Specify a password for the trading partner that you receive from the trading partner.

Retry Count Specify the maximum number of times TIBCO BusinessConnect tries to reconnect to 
the remote HTTP server, in case of failures.

The default value is 3.

Retry Interval Specify the interval between which TIBCO BusinessConnect waits before another 
reconnection is attempted, in seconds.

The default value is 60.

Socket Timeout Specify the amount of time a socket blocks on a read operation, in seconds.

The default value is 300.

Table 31   Configuring NAESB Internet ET (Sheet 2 of 4)

Field Description
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Cipher Suite 
Grade

(HTTPS only) 

Select the cipher grade (strength) from the list.

• All

• Only Stronger Than Export

• Only 128-Bit and Stronger

• Only Stronger Than 128-Bit

• Only 256-Bit and Stronger

All ciphers are listed in TIBCO BusinessConnect Concepts, "Cipher Suites."

Can use TLS

(HTTPS only)

Select this check box to use the Transport Layer Security (TLS) cryptographic protocol.

TLS Version

(HTTPS only)

Select the version of TLS protocol.

TLS protocol versions 1.0, 1.1, and 1.2 are supported.

Note: If you select TLS version 1.1 or 1.2, you have to select Sun as the security vendor 
for inbound and outbound socket operations.

Can use SSLv3

(HTTPS only)

Select this check box to use the Secure Socket Layer version 3 (SSLv3) cryptographic 
protocol.

GISB/NAESB

GISB/NAESB 
Package

Select this check box to package outbound messages in the NAESB Internet ET format.

By default, this check box is cleared.

GISB/NAESB 
Version

Specify the GISB/NAESB version.

The default value is 2.0.

Receipt Signature 
Required

Select this check box to support the receipt signature.

When you select this check box, the outbound NAESB message contains a 
"receipt-security-selection" data element that instructs the responder to sign the receipt 
(including the synchronous receipt and asynchronous error notification) that is sent 
back.

By default, this check box is cleared.

PGP Processing 

Table 31   Configuring NAESB Internet ET (Sheet 3 of 4)

Field Description
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PGP Encrypt Select this check box to enable PGP encryption.

By default, this check box is selected.

PGP encryption in ASCII Armor format is mandatory for requests.

This setting takes effect only for a regular outbound request and not for an outbound 
Error Notification, which is never encrypted according to the NAESB standard.

PGP Sign Select this check box to support PGP signature.

This is optional. By default, this check box is cleared. 

This setting takes effect only for a regular outbound request and not for an outbound 
Error Notification. 

The "receipt-security-selection" data element in the original inbound NAESB message 
defines whether an error notification is signed.

Note that other PGP features, such as Compression and Compression Algorithm, are 
not configured since NAESB messages are not compressed.

Table 31   Configuring NAESB Internet ET (Sheet 4 of 4)

Field Description
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Chapter 6 Configuring Agreement Protocol Bindings

This chapter explains how to configure protocol bindings for business agreements.

Topics

• Overview, page 148

• Operation Bindings Tab, page 149

• Overriding Outbound Settings for Notify, page 150

• Overriding Outbound Settings for Synchronous Response Request, page 156

• Document Security Tab, page 165

• Transports Tab, page 167

• Scheduled Transmission Tab, page 170

• Overriding Participant Settings, page 172
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Overview

An agreement protocol binding is contained within a business agreement. For information 
on business agreements, see TIBCO BusinessConnect Trading Partner Administration.

Adding Protocol Binding

To configure an agreement protocol binding:

1. Log on to TIBCO Administrator.

2. In the left panel, expand BusinessConnect > Business Agreements. 

3. In the right panel, click a business agreement link.

4. Click Add Protocol Binding. 

5. Select the X12 check box.

6. Click OK.

7. Click the X12 agreement protocol binding link. The following configuration options 
are available:

— Operation Bindings Tab, page 149

— Document Security Tab, page 165

— Transports Tab, page 167

— Scheduled Transmission Tab, page 170

— Overriding Participant Settings, page 172
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Operation Bindings Tab

In the Operation Bindings tab, you can configure the X12 transactions that each 
participant in a business agreement can initiate and respond to. 

The following properties apply to all the transactions that you import in the Operations 
Editor:

• Allow All Operations Enables participants to initiate all operations configured in 
BusinessConnect. You can modify the behavior of one or more operations by binding 
the operations in the Hosts’ Can Initiate and Partners’ Can Initiate areas. 

• Non Repudiation Logging Enables logging of all operations in the non-repudiation 
log.

Adding Operation Binding

The Host ’X’ Can Initiate area where X is the host participant in the business agreement 
lists the transactions that the host can initiate and the partner can respond to. The Partner 
’Y’ Can Initiate area where Y is the partner participant in the business agreement lists the 
transactions that the partner can initiate and the host can respond to. 

To bind a transaction in either area:

1. Click Add Operation Bindings.

2. Click the topmost expand all  to expand the transaction tree.

Check the transaction.

3. Click OK.

The selected message is added to the Operation Name list.

You can continue by editing this operation binding.

For synchronous request response transactions: when you clear this check box, the 
following situations happen

• Both the acknowledgment creation at the Responder side and the synchronous 
response received at the Initiator side are supported, regardless of whether a binding is 
available. 

• Initiator’s synchronous requests are be checked for binding availability.
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Overriding Outbound Settings for Notify 

To override the outbound settings for a Notify operation binding, select it first.

• Operation Settings Override the default settings for this operation. 

See Operation Settings Tab, page 150.

• Action Settings To override the action settings for a transaction, select the Override 
Action Settings check box. 

Options in this tab override configuration set in the Action Settings Tab, page 154.

• Transports To override the transports for a transaction, select the Override 
Transports check box. 

Options in this tab override configurations set in the Transports Tab, page 167.

• Document Security To override the document security for a transaction, select the 
Override Document Security check box. 

Options in this tab override configurations set in the Document Security Tab, 
page 165.

Operation Settings Tab

To override outbound settings for a Notify operation, select the Override Operation 
Settings check box. If you select to override operation settings, continue by selecting one 
of the following items from the list: 

• General Option, page 151

• Guideline Option, page 152

• Schema Option, page 154

When no guidelines are given for the operation binding with the Override Operation 
Settings check box selected and with the Allow all Operation check box selected, the 
guideline in the operations editor takes effect.

If transactions of same operation type are batched, the override settings for the particular 
operation binding take effect only when these transactions are transmitted for the 
interchanges with multiple groups of the same transaction type. In addition, these 
overrides cannot take effect when batch transmission is performed through a gateway.
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General Option

The following options are available when overriding the settings:

Table 32   Override Settings for Notify: General

Field Description

GS02 Sender/GS03 
Receiver (for example, 
Application Sen: 
Application Rec)

Specify the GS02/GS03 values for outbound and inbound messages to restrict 
or support transactions.

When GS02/GS03 values are given under operation binding with the Allow 
All Operations check box unselected, only transactions containing the 
GS02/GS03 pair given under the operation binding are supported to be sent or 
received. If this condition is not met, transactions are restricted and they are 
neither sent nor received.

Inbound
Raw EDI Segments

Include in Private Process 
Request

Select this check box to include raw EDI message in the private process 
(RESPONDER.REQUEST) for this operation. 

By default, this check box is cleared.

Include in Validation 
Error Advisory

Select this check box to include raw EDI messages in the Validation Error 
advisory.

By default, this check box is selected.

Extra Transaction Info Specify a value used to send any information to the private process at 
transaction level of RESPONDER.REQUEST message.

It can also be included in RESPONDER.INTERCHANGE and ValidationAlert advisory.

Security Option (MIME 
Encode Message Only)

Select one item from the list to support or deny only this transaction. The 
Security Option is at the transaction level. If the incoming document contains 
multiple transaction sets, the transaction that does not match the security 
option is not sent to the private process. This does not affect acknowledgment 
creation for the incoming X12 document.

The options are:

• None

• Plain Text Only

• Signed Only

• Encrypted Only

• Signed and Encrypted
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Guideline Option

If Guideline is selected, you can change or remove Validation Guidelines and TEXT 
Translation Guidelines as explained in Table 33.

Table 33   Override Settings for Notify: Guideline (Sheet 1 of 3)

Field Description

Validation Guideline

Guideline File for 
validating X12 Partner 
data (.sef or .std)

Click change to select and load the guideline file associated with this message 
type. Then, follow the procedure described in TIBCO BusinessConnect Trading 
Partner Administration, "File Specification Dialog."

The guideline file associated with this message type. 

Validator Profile File 
(.apf)

Click change to select and load the Validator profile file. 

Validator profile files are used to check errors and categorize them to different 
levels of severity. For details, see Configuring Validation Profile (.apf) Files.
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Allow Dynamic 
Guideline Loading 
based on GS02 
Sender/GS03 Receiver

If you select this check box, the guideline associated with this message type is 
determined by the GS02 and GS03 value in the message, and loaded from file 
system, rather than using the default guidelines specified in Guideline File for 
validating X12 Partner data.

You can use the GS0203_guidelines.map file in the 
TIBCO_HOME/bc/version_number/protocols/tibedi/config directory to predefine the 
guideline file name for each GS02/GS03 pair. The format of each line of the file 
is: Key = full path of guideline file. See this file for more details.

The original guideline file name defined in Guideline File for validating X12 
Partner data and GS02 Sender/GS03 Receiver Group Headers in the message 
are used to form the Key to search in this file. 

Search is conducted in the following order:

1. Original file name_GS02 Sender_GS03 Receiver

If a key that matches the original guideline name and both the GS02 and 
GS03 values, the file path in this line is used for loading the specific 
guideline file.

2. Original file name_GS02 Sender

If the key in step 1 is not found, the key that matches the original name and 
the GS02 value is picked up, and the file path in this line is used.

3. Original file name_GS03 Receiver

If the key in step 2 is not found, the key with the original name and the 
GS03 value is picked up, and the file path in this line is used.

Note: 

• Duplicate Keys are not supported in the map file.

• If no key matches, the default guidelines specified in Guideline File for 
validating X12 Partner data are used.

• If any character exists in GS02 and GS03 that is not permitted for file path, 
such as / \\ : ? * \ < > |, and spaces, these characters are all replaced by 
underscores (_) to form the search key.

Inbound
Type of Translation

Table 33   Override Settings for Notify: Guideline (Sheet 2 of 3)

Field Description
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Schema Option

If Schema is selected, you can change or remove the Map file as explained in Table 34.

Action Settings Tab

The Action Settings tab is available only for the Host. 

It provides the following options:

• Override Action Settings If selected, this option overrides the action settings 
selected by using BusinessConnect > Participants > Partner> Protocols > X12 > 
Batching tab and BusinessConnect > Participants > Partner > Protocols > X12 > 
Acknowledgement tab.

Inbound X12 
Translation Type (e.g. 
EDI to XML or EDI to 
TEXT)

Select one item from the list to specify the inbound X12 transaction type.

• EDI to XML When you select EDI to XML, it supports EDI to XML 
translation; an appropriate translation map has to be uploaded so that the 
output is XML.

• EDI to TEXT When you select EDI to TEXT, with proper TEXT guideline 
and appropriate translation map for mapping EDI to TEXT, the output is 
translated to TEXT.

TEXT Translation Guideline

Guideline File used for 
translating X12 to 
TEXT (.sef or .std)

Click change to select and load a guideline file for X12 to TEXT translation.

Table 33   Override Settings for Notify: Guideline (Sheet 3 of 3)

Field Description

Table 34   Override Settings for Notify: Schema

Field Description

EDI to XML (or EDI to 
TEXT) Translation Map 
file (.map)

Click change to select and load the EDI to XML or EDI to TEXT translation 
map file associated with this message type. 

Note that EDI to XML translation map files have the extension _EX.map.

XML to EDI translation 
Map file (.map)

Click change to select and load the XML to EDI translation map file associated 
with this message type. 

Note that XML to EDI translation map files have the extension _XE.map.
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• Batching Option To override outbound action settings for batching, see Table 8, 
Outbound Action: Batching Tab, page 76.

• Acknowledgement Option To override outbound action settings for 
acknowledgments, see Table 9, Outbound Action: Acknowledgement Tab, page 77.

Transports Tab

The Transports tab is available only for the Host. 

It provides the following options:

• Override Transports If selected, this option overrides the transports as explained in 
Transports Tab, page 167.

• Override Outbound Transports You can override these transports by selecting 
which one is the Primary and which one is the Backup transport, or by selecting None 
(no changes).

— Primary Transport Select one of the existing configured transports, or None.

— Backup Transport Select one of the existing configured transports, or None.

Document Security Tab 

The Document Security tab is available both for the Host and for the Partner. 

It provides the following options:

• Override Document Security If selected, this option overrides the transports.

• Outbound Doc Exchange See Document Security Tab, page 165.
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Overriding Outbound Settings for Synchronous Response Request 

To override the outbound settings for a Synchronous Response Request operation binding, 
select it first.

• Operation Settings Override the default settings for this operation. 

See Operation Settings Tab, page 156.

• Action Settings To override the action settings for a transaction, check the Override 
Action Settings check box. 

Options in this tab override configuration set in the Action Settings Tab, page 162.

• Transports To override the transports for a transaction, select the Override 
Transports check box. 

Options in this tab override configurations set in the Transports Tab, page 167.

• Document Security To override the document security for a transaction, select the 
Override Document Security check box. 

Options in this tab override configurations set in the Document Security Tab, 
page 165.

Operation Settings Tab

To override outbound settings for a Synchronous Response Request, select the Override 
Operation Settings check box. If you select to override operation settings, continue by 
selecting one of the following from the list: 

• General Option, page 157

• Guideline Option, page 158

When no guidelines are given for the operation binding with the Override Operation 
Settings enabled and with Allow all Operation check box selected, the guideline in the 
operations editor takes effect.

If transactions of this operation are batched, the override settings in this operation binding 
take effect only when these transactions are not transmitted in the same outbound 
transmission with other operation transactions. In addition, these overridings cannot take 
effect when the batch transmission is performed through a gateway.
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General Option

The following options are available when overriding the settings:

Table 35   Override Settings for Synchronous Request Response: General 

Field Description

GS02 Sender/GS03 
Receiver (for example, 
Application Sen: 
Application Rec)

Specify the GS02/GS03 values for outbound and inbound messages to restrict 
or support transactions.

When GS02/GS03 values are given under operation binding with the Allow 
All Operations check box unselected, only transactions containing the 
GS02/GS03 pair given under the operation binding are supported to be sent or 
received. If this condition is not met, transactions are restricted and they are 
neither sent nor received.

Inbound

Include in Private Process 
Request

Select this check to include raw EDI message in the private process 
(RESPONDER.REQUEST) for this operation. 

By default, this check box is cleared.

Include in Validation 
Error Advisory

Select this check box to include raw EDI messages in the Validation Error 
advisory.

By default, this check box is selected.
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Guideline Option

If Guideline is selected, you can change or remove Validation Guidelines and TEXT 
Translation Guidelines as explained in Table 33.

Table 36   Override Settings for Synchronous Request Response: Guideline (Sheet 1 of 4)

Field Description

Allow Dynamic 
Guideline Loading 
based on GS02 
Sender/GS03 Receiver

If selected, the guideline associated with this message type is determined by the 
GS02 and GS03 value in the message, and loaded from file system, rather than 
using the default guidelines specified in Request Guideline File and Response 
Guideline File.

You can use the GS0203_guidelines.map file in the 
TIBCO_HOME/bc/version_number/protocols/tibedi/config directory to predefine the 
guideline file name for each GS02/GS03 pair. The format of each line of the file 
is: Key = full path of guideline file. See this file for more details.

The original guideline file name defined in Request Guideline File and 
Response Guideline File, and GS02 Sender/GS03 Receiver Group Headers in 
the message are used to form the Key to search in this file. 

Search is conducted in the following order:

1. Original file name_GS02 Sender_GS03 Receiver

If a key that matches the original guideline name and both the GS02 and 
GS03 values, the file path in this line is used for loading the specific 
guideline file.

2. Original file name_GS02 Sender

If the key in step 1 is not found, the key that matches the original name and 
the GS02 value is picked up, and the file path in this line is used.

3. Original file name_GS03 Receiver

If the key in step 2 is not found, the key with the original name and the 
GS03 value is picked up, and the file path in this line is used.

Note: 

• Duplicate Keys are not supported in the map file.

• If no key matches, the default guidelines specified in Request Guideline 
File and Response Guideline File are used.

• If there is any character in GS02 and GS03 that is not permitted for file path, 
such as / \\ : ? * \ < > |, and spaces, these characters are all replaced by 
underscores (_) to form the search key.
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Request
Type of Translation

Inbound Translation 
Type (e.g. EDI to XML 
or EDI to TEXT)

From the drop-down menu, select one of these two choices:

• EDI to XML This is the default value.

When you select EDI to XML, the inbound Synchronous X12 document is 
translated to XML. It can be overridden at the business agreement level to 
do EDI to TEXT translation. For details, see Table 33, Override Settings for 
Notify: Guideline.

• EDI to TEXT  When you select EDI to TEXT, the appropriate synchronous 
X12 document is translated to TEXT. 

When a proper TEXT guideline is uploaded and an appropriate translation 
map for mapping EDI to TEXT is created, the output is a TEXT file.

Table 36   Override Settings for Synchronous Request Response: Guideline (Sheet 2 of 4)

Field Description
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X12 Validation Guideline for Request

Request Guidelines File 
(.sef or .std)

Specify the path to the inbound synchronous request guidelines file. You can 
override this field at the business agreement level. This guideline file is used to 
validate the EDI document that is received from a trading partner, or that is sent 
to a trading partner.

Click change to select and load the Guidelines File (.sef or .std).

Request Validator 
Profile File (.apf)

Specify the path to the inbound synchronous request Validator Profile file that 
you want to suppress errors into warning or information. You can override this 
field at the business agreement level.

Click change to select and load the Validator Profile file (.apf).

TEXT Translation Guideline

Guideline File used for 
translating X12 to 
TEXT (.sef or .std)

Click change to select and load a guideline file for translating X12 to TEXT. 

This TEXT guideline is used for translating a X12 EDI document into a TEXT 
document.

Acceptance Response
X12 Validation Guideline for Response

Response Guidelines 
File (.sef or .std)

Specify the path to the outbound synchronous response Guidelines file. You can 
override this field at the business agreement level. 

This guideline file is used to validate the synchronous response EDI document 
that is received from a trading partner, or that is sent to a trading partner.

Click change to select and load the Guidelines File (.sef or .std).

Response Validator 
Profile File (.apf)

Specify the path to the outbound synchronous response Validator Profile file that 
you want to suppress errors into warning or informational if the responses have 
errors. You can override this field at the business agreement level.

Click change to select and load the Validator Profile File (.apf).

Table 36   Override Settings for Synchronous Request Response: Guideline (Sheet 3 of 4)

Field Description
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TEXT Translation Guideline

Guideline File used for 
translating EDI 
response to TEXT (.sef 
or .std)

Click change to select and load a guideline file for translating EDI to TEXT.

This TEXT guideline is used for translating a synchronous X12 response EDI 
document into a TEXT document.

Type of Translation

Backend to Partner 
Translation type for 
Response (e.g. XML to 
EDI or TEXT to EDI)

• XML to EDI

• TEXT to EDI  TEXT data can be sent from the private process, converted to 
the EDI data and sent back to the Initiator.

For more information, see TIBCO BusinessConnect EDI Protocol powered 
by Instream User’s Guide, "TEXT to EDI Conversion."

TEXT Translation Guideline

Guideline File used to 
translate TEXT to EDI 
response (.sef or .std)

Click change to select and load a guideline file for translating TEXT to EDI.

This TEXT guideline is used for translating a TEXT document into synchronous 
X12 response EDI document.

Rejection Ack

Rejection Ack 
Guidelines File (.sef or 
.std)

Specify the path to the Rejection Ack Guidelines file. You can override this field 
at the business agreement level.

Click change to select and load the Rejection Ack Guidelines File (.sef or .std).

You can use this guideline file to validate the synchronous EDI rejection 
acknowledgment document that is received from a trading partner, or sent to a 
trading partner.

Inbound Translation Guideline for Rejection Ack

Guideline File used to 
translate EDI rejection 
Ack to TEXT (.sef or 
.std)

Click change to select and load a guideline file for translating EDI rejection Ack 
to TEXT.

This TEXT guideline is used for translating a synchronous X12 rejection 
acknowledgment EDI document into a TEXT document.

Table 36   Override Settings for Synchronous Request Response: Guideline (Sheet 4 of 4)

Field Description
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Action Settings Tab

The Action Settings tab is available only for the Host. 

It provides the following options:

• Override Action Settings If selected, this option overrides the action settings 
selected by using the BusinessConnect > Participants > Partner > Protocols> X12 
> Batching tab and BusinessConnect > Participants > Partner > Protocols > X12 > 
Acknowledgement tab.

General Option

With this option, you can change the value for Time to Wait for Sync Response (seconds).
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Translation Map Option

Transports Tab

The Transports tab is available only for the Host. 

It provides the following options:

• Override Transports If selected, this option overrides the transports as explained in 
Transports Tab, page 167.

Table 37   Override Settings for Synchronous Request Response: Translation Map Option

Field Description

Acceptance Response

Response EDI to XML (or 
EDI to TEXT) Translation 
Map File (.map)

Select the EDI to XML or EDI to TEXT translation map file.

• If you select EDI to TEXT as the inbound type of translation, the 
appropriate X12 to TEXT translation map must be uploaded for the 
translation to occur.

• If you select EDI to XML as the inbound type of translation, the 
appropriate X12 to XML translation map must be uploaded for the 
translation to occur. Note that EDI to XML translation map files have the 
extension _EX.map.

Response XML to EDI (or 
TEXT to EDI) translation 
Map File (.map)

Select the XML to EDI or TEXT to EDI translation map file.

This file is associated with this message type for sending the synchronous 
response to a trading partner that is received from the private process.

Note: XML to EDI translation map files have the extension _XE.map.

For TEXT to EDI translations, see TIBCO BusinessConnect EDI Protocol 
powered by Instream User’s Guide, "TEXT to EDI Conversion."

Rejection Ack

Rejection Ack EDI to 
XML (or EDI to TEXT) 
Translation Map File 
(.map)

Select the EDI to XML or EDI to TEXT translation map file. 

• If you select EDI to TEXT as the inbound Type of Translation, the 
appropriate X12 to TEXT translation map must be uploaded for the 
translation to occur.

• If you select EDI to XML as the inbound Type of Translation, the 
appropriate X12 to XML translation map must be uploaded for the 
translation to occur. Note that EDI to XML translation map files have the 
extension _EX.map.
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• Override Outbound Transports You can override these transports by selecting 
which one is the Primary and which one is the Backup transport, or by selecting None 
(no changes).

— Primary Transport Select one of the existing configured transports, or None.

— Backup Transport Select one of the existing configured transports, or None.

Document Security Tab 

The Document Security tab is available both for the Host and for the Partner. It provides 
the following options:

• Override Document Security If selected, this option overrides the transports as 
explained in Table 38, Document Security Fields.
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Document Security Tab

In the Document Security tab, you can specify security information for trading partners. 

The keys and certificates selected in the tab are set in the host and partner participant’s 
Credentials tabs. For information on how to set credentials, see TIBCO BusinessConnect 
Trading Partner Administration. The properties listed in Table 38 can be set for inbound 
and outbound document exchange.

Overriding Document Security

When you select this check box, the configured document security settings are overridden.

The document security settings you configure in the business agreement are the default 
values. You can override these values only for outbound documents.

If you are using a transporting Gateway with one or more X12 trading partners, the 
document security settings in the transporting Gateway are used instead of the document 
security settings for any of those X12 trading partners. 

For more information about configuring the Gateway, refer to the TIBCO 
BusinessConnect EDI Protocol powered by Instream, Gateway Configuration.

Table 38   Document Security Fields

Field Description

Outbound Doc Exchange
Signing Info Settings

Signing Key The key the host uses to sign a message in order to identify itself to a partner. The 
partner uses the host’s certificates file to authenticate the host by verifying the digital 
signature of the host.

Digest Algorithm The algorithm used to create the digest to be used for digital signatures:

SHA1, SHA256, SHA384, SHA512

PGP Signing 
Private Key

The PGP key the host uses to sign a message in order to identify itself to a partner. 

PGP Hash 
Algorithm

The PGP algorithm used to create the digest to be used for digital signatures:

SHA1 and RIPEMD160

Encryption Info Settings
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Encryption 
Certificate

The certificates file the host uses to encrypt a document before sending it to the partner. 
The partner uses its own host key identity file to decrypt the document. 

You must obtain this certificate from the host in advance.

Encryption 
Algorithm

The algorithm used to encrypt documents:

DES3, AES-128, AES-192, AES-256.

PGP Encryption 
Public Key

The PGP public key the host uses to encrypt a document before sending it to the partner. 

PGP Encryption 
Algorithm

The PGP algorithm used to encrypt documents:

DES3, BLOWFISH, CAST5, AES-128, AES-192, AES-256.

Inbound Doc Exchange
Signing Info Settings

Verification 
Certificate

The partner identifies itself by signing a document with its own host identity file. The 
host uses this certificate to authenticate a partner by verifying the digital signature of the 
partner. You must obtain this certificate from the host in advance.

PGP Signing 
Verification 
Public Key

The host uses this PGP public key to authenticate a partner by verifying the digital 
signature of the partner.

Encryption Info Settings

Decryption Key The host uses part of the host key identity file to decrypt a document that the partner 
encrypted using the host’s certificates file.

PGP Decryption 
Private Key

The host uses this PGP private key to decrypt the document.

Table 38   Document Security Fields (Cont’d)

Field Description
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Transports Tab

In the Transports tab, you can configure the supported outbound and inbound transport 
for the host and the partner participant in the business agreement.

The top section of this tab is used for selecting transports for the outbound, or host to 
trading partner, direction. The bottom section of the tab is used for selecting and 
configuring transports for the inbound, or trading partner to host, direction.

Setting the Outbound Transport for the Host

Select an outbound primary and backup transport. The transports are configured in a 
trading partner’s Protocols > Transports tab. 

See Transports Tab, page 141.

Table 39   Outbound Transport for the Host

Field Description

Primary Transport See the Transports chapters in the TIBCO BusinessConnect Trading Partner 
Administration. 

Backup Transport TIBCO BusinessConnect EDI Protocol powered by Instream supports a backup 
outbound transport for sending XML files to the trading partner. This backup 
transport is used if the file cannot be sent over the primary transport configured in 
the business agreement. Such situation might happen if the trading partner’s server 
is not available or has a wrong URL during the time when the file is being sent: 
the file still needs to reach the server through some other means even after the 
primary transport retry is exhausted.

Backup transports are configured at the business agreement level and can be one 
of the supported BusinessConnect transports. The same rules apply for choosing a 
backup transport as for a primary transport.

Note  Backup transport currently does not support NAESB packaging.
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Setting the Inbound Transport for the Host

What is displayed in this area depends on the transports that are selected in the Transport 
Type area of Public Process Configuration tab. For further information, see TIBCO 
BusinessConnect Trading Partner Administration, "Deployment Configuration."

AS2 Async MDN 
Reply Transport

Same as for TIBCO BusinessConnect.

Select any of the configured transports. The settings from the specified AS2 MDN 
Async Reply Transport field are used for sending async MDN responses back to 
your trading partner. Configuring the AS2 MDN Async Reply Transport field is 
not necessary unless you want to specify different values for the following HTTP 
transmission related settings: 

• Retry Count – default is 3

• Retry Interval – default is 60 seconds

• Socket Timeout – default is 300 seconds (5 minutes)

Any other settings specified in the AS2 MDN Async Reply Transport field are 
ignored. The most common case, which you specify this transport for, is when 
your trading partner is not acknowledging the receipt of your async MDNs within 
the default socket timeout period.

AS2 Async MDN 
Remote Server 
Certificate

Same as for TIBCO BusinessConnect.

The Remote Server Certificate for the AS2 HTTPS transport is a SSL certificate 
that must be used for encrypting the data sent using HTTPS. This list contains all 
of the certificates that are configured for the trading partner. You can select the 
one that is configured to be used for SSL encryption.

Note The server certificate configuration is only required for Async MDNs over 
the AS2 HTTPS transport. 

Client Authentication 
Identity for HTTPS, 
FTPS, HTTPSCA

Choose between the transport that is set up as Client Authentication Identity for 
HTTPS, FTPS, HTTPSCA, or None.

Client Authentication 
Identity for SSHFTP

Choose between the transport that is set up as Client Authentication Identity for 
SSHFTP, or None.

Table 39   Outbound Transport for the Host (Cont’d)

Field Description
TIBCO BusinessConnect EDI Protocol powered by Instream X12 Configuration



Transports Tab | 169
Table 40   Inbound Transport Fields

Field Description

HTTP/S Support HTTP/S connections from this partner directly or from a VAN. This also applies 
when the inbound connection is using the AS2 transport. 

HTTPSCA/AS2 See TIBCO BusinessConnect Trading Partner Administration, Chapter 11, "HTTP, 
HTTPS, and HTTPSCA Transports."

FTP/S Support the host to perform FTP/S connections with this partner. The host is the Initiator 
of the FTP process. Click Edit Settings to configure FTP/S. For more information on 
how a host uses FTP, see TIBCO BusinessConnect Trading Partner Administration 
Guide.

EMAIL Support email from this partner or from a VAN. This also applies when the inbound 
connection is using the AS1 transport. If your partner uses EMAIL and a transporting 
Gateway to send EDI documents back to you through a VAN, you have to configure the 
FTP transport. You must use FTP to get your partner documents from the VAN site. This 
is because a VAN receives documents for multiple trading partners, but does not forward 
those documents to the recipients.

FILE Support FILE connections from this partner. FILE is normally used for file exchange 
within an enterprise. If your partner uses FILE and a transporting Gateway to send EDI 
documents back to you through a VAN, you have to configure FTP transport. You must 
use FTP to get your partner documents from the VAN Gateway site. This is because a 
VAN receives documents for multiple trading partners, but does not forward those 
documents to the recipients.

SSHFTP See TIBCO BusinessConnect Trading Partner Administration, Chapter 15, "SSHFTP 
Transport."
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Scheduled Transmission Tab

In the Scheduled Transmission tab, you can specify when transactions are transmitted to 
this trading partner. The settings in this tab interact with the settings in the Batching tab in 
the Operations Editor. 

See Outbound Action: Batching Tab on page 76.

By default, transactions are transmitted to your trading partners immediately after TIBCO 
BusinessConnect EDI Protocol powered by Instream processes them. Using the options in 
the Scheduled Transmission tab, transactions can be scheduled to be sent:

• Only during a specified time period

• Only on certain days of the week

• Only on certain dates

If you use this tab to control when messages are transmitted, you can use the Log Viewer 
to view, submit manually, and delete queued messages. 

See TIBCO BusinessConnect EDI Protocol powered by Instream User’s Guide, Chapter 7, 
"Viewing Logs."

Table 41   Scheduled Transmission Fields

Field Description

Enable Enable this configuration.

Transmission 
Mode

Specify the type of the transmission schedule: Everyday, Day of the Week, or Specific 
Dates. The selection determines which of the other fields on the tab are used. 

Start Time Define the start of the transmission window.

End Time Define the end of the transmission window.

Days of the Week Specify the days of the week that messages are transmitted. Used when the mode is Day 
of the Week.
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Frequency Specify how often to group transactions into a single interchange and send them to 
trading partner. The frequency you specify applies to the scheduled transmission start 
time. The first set of transmissions are at the scheduled transmission start time. Each 
subsequent set of transmissions are at the start time plus the frequency interval 
specified. TIBCO BusinessConnect continues sending transmissions at regular intervals 
based on the value in the Frequency field until the transmission window closes.

For example, if the start time is 9:00 AM and the frequency is Every 30 mins, the first 
set of transmissions occur at 9:00 AM, the next set of transmissions occur at 9:30 AM, 
and so on.

If you use a Gateway (override scheduler and transport settings) field (see Batching Tab 
on page 124), the frequency setting in the Gateway General tab overrides any value in 
this field. 

Transaction 
Count Threshold

Limit the number of transactions in an interchange. The minimum value is 1. 

If scheduled transmissions are enabled, entering a number causes the following 
situations to occur when the transmission window opens:

• If the number of transactions to be sent to this trading partner reaches the number 
specified in this field before the next transmission time is reached, all transactions 
up to the number specified are grouped together into a single interchange and sent 
to the trading partner.

• If the next transmission time is reached before the specified number of transactions 
are ready to be transmitted, the transactions that are ready are be grouped together 
into a single interchange and sent to the trading partner.

If you use a Gateway in the (override scheduler and transport settings) field (see 
Batching Tab on page 124), the Number of Transactions Reached setting in the 
Gateway General tab overrides any value in this field. 

Scheduled Dates Specify the list of dates when transmissions occur. Used when the mode is Specific 
Dates.

Click Add to add a specific date. 

Table 41   Scheduled Transmission Fields (Cont’d)

Field Description
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Overriding Participant Settings

Use the participant configuration tabs to override the general settings for a participant per 
agreement protocol binding. 

Hide Advanced

To hide the participant configuration tabs and skip overriding the participant settings, click 
Hide Advanced.

Show Advanced

To use the participant configuration tabs, click Show Advanced. 

The configuration GUI displays two tabs labeled ParticipantA’s Configuration and 
ParticipantB’s Configuration, where ParticipantA and ParticipantB are the participants in 
the business agreement, which you are overriding the settings for. 

Overriding General Settings

This procedure describes how to override a general setting.

1. Click the participant configuration tab.

2. Select the Override Settings check box.

3. Default Interchange Qualifier ID Select an interchange qualifier ID from the list.

Choices for the Host are fully explained in the General Tab, page 105.

Choices for the Trading Partner are fully explained in General Tab, page 117. 

4. AS2 Identifier Select an AS2 identifier from the list.

Choices for the Host are fully explained in the General Tab, page 105.

Choices for the Trading Partner are fully explained in General Tab, page 117

5. Common Code Identifier Select the common code identity from the list.

Choices for the Host are fully explained in the General Tab, page 105.

Choices for the Trading Partner are fully explained in General Tab, page 117

6. Valid Email Address List Enter the valid email address or addresses.

When the default interchange qualifier is changed, no CSUPDATE advisory is published.
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7. CAQH UserName to authenticate at Partner Enter the user name.

Choices for the Host are fully explained in the General Tab, page 105.

8. CAQH Password to authenticate at Partner Enter the password.

Choices for the Host are fully explained in the General Tab, page 105.

9. Click Save to save the configurations.
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